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Kurzfassung

Die vorliegende Arbeit richtet sich an alle, die sich mit 3D Modellierung im
Allgemeinen und fur die Gestaltung von Aulenbereichen im

dreidimensionalen Raum interessieren.

Diese Arbeit beschreibt den Prozess der Erstellung einer virtuellen Szene.
Angefangen bei der Modellierung des Gelandes und der Vegetation, wird
spater auch auf die Erstellung komplexerer Materialien wie Wasser oder
Wolken eingegangen. Es werden die Anforderungen fir die
fotorealistische Reproduktion festgelegt und in Maya verschiedene
Techniken, die zu diesem Ziel fuhren miteinander verglichen. Des
Weiteren werden neben der Modellierung und Texturierung auch
unterschiedliche Beleuchtungsarten hinsichtlich der Eignung auf
Fotorealismus untersucht. Letztlich wird noch ein genauer Blick auf den

Renderingprozess und verschiedene Renderingeffekte geworfen.

Die vorliegende Arbeit baut auf das Praxisprojekt ,Erstellung eines
realistischen 3D Modells der Fachhochschule unter Verwendung von
Autodesk Maya“ auf. Bereits gesammelte Erfahrungen und Ergebnisse

flieBen in die vorliegende Arbeit ein.



Abstract

The present assignment is addressed to all who are interested in 3D
Modelling in general and in designing outskirt areas in three-dimensional

space.

It describes the process of creating a virtual scene, beginning with the
modelling of terrain and vegetation, leading to the creation of complex
materials like water and clouds. Starting with the requirements, several
techniques will be taken into account and analyzed to define which are
best for photorealistic rendering. Furthermore, besides modelling and
texturing, several lighting techniques will be compared with each other.
Finally, the rendering process and different rendering effects will be looked

at in detail.

This assignment is based on the ,Praxisprojekt” ,Erstellung eines
realistischen 3D Modells der Fachhochschule unter Verwendung von

Autodesk Maya“. Gained experiences and results are used in the task.
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1 Einleitung

Die technische Weiterentwicklung der heutigen Zeit ermdglicht immer
aufwandigere und detailliertere Simulationen realer Ablaufe in einer
virtuellen Welt. Die Begeisterung fur neue Generationen fotorealistischer
Computerspiele oder die Umsetzung aufwandiger Szenen in Kinofilmen
werden erst durch den Einsatz real wirkender Aulienbereiche ermdglicht.
Um ein Hochstmall an Qualitat zu gewahrleisten ist es notwendig die

Natur in ihrer ganzen Komplexitat virtuell darzustellen.

Die Nachempfindung der Eigenschaften der Natur in computergenerierte
Bilder stellt daher eine aulerordentliche Herausforderung dar. Das
menschliche Auge nimmt in der realen Welt eine Vielzahl an Informationen
auf, die nicht bewusst bis in jedes Detail wahrgenommen werden. Diese
Details mussen im 3D Design umgesetzt werden, um uberzeugende,
fotorealistische Bilder zu erzeugen. Diese Eigenschaften stellen demnach
fur die 3D Reproduktion eines AulRenbereichs hohe Anforderungen an die
Detailgenauigkeit der modellierten Geometrie und der Texturinformation.
Bereits kleine Abweichungen des gerenderten Bildes werden vom
Betrachter erkannt. Bei computergenerierten Bildern fallen oft
Abweichungen oder Fehler auf, welche im ersten Moment nicht genau
beschrieben werden koénnen. Es ist jedoch genau definierbar, was an

diesem Bild realistisch aussieht und was nicht.

Gesteigerte Rechnerleistung und stetige Weiterentwicklung der 3D
Visualisierungssoftware und der verwendeten Renderer ermoglichen
fotorealistische Ergebnisse. Heutzutage ist es moglich, selbst schwer zu
simulierende Phanomene wie Kaustiken' realistisch zu erzeugen. Die
technische Maoglichkeit allein ist aber nicht ausreichend. Um Vorgange der
Natur wiederzugeben, mussen diese in ihrem Entstehen verstanden
werden. Das Licht, welches in seiner Art mit Materialien auf eine jeweils

andere Art reagiert oder das Verstehen der Funktionsweise eines

' ,Bei einem optischen System die einhiillende Flache derjenigen Punkte, in denen sich
die Bildstrahlen eines parallel einfallenden Lichtbundels schneiden®. [BHA02]



Shaders? ist das fundamentale Basiswissen einer fotorealen Reproduktion.
Diese Arbeit soll einen genauen Uberblick Uber die Méglichkeiten,
Schwierigkeiten und Besonderheiten dieses Produktionsprozesses geben

und Losungsvorschlage anbieten.

2Vgl. Kapitel 6.3 Shading



2 Beschreibung der Arbeit

Dieses Kapitel beschreibt die genaue Themenstellung der vorliegenden
Arbeit und legt somit den Grundstein fur die Struktur und ihren Inhalt.
Danach werden die Anforderungen an die Arbeit geklart und letztlich der
Aufbau im Detail erlautert. Das Kapitel hat als Ziel, den Leser in das

Thema einzufiihren.

2.1 Themenstellung

Die vorliegende Arbeit baut auf das Praxisprojekt ,Erstellung eines
realistischen 3D Modells der Fachhochschule unter Verwendung von
Autodesk Maya“ auf. Ziel des Praxisprojektes war es, ein realistisches

Modell der Fachhochschule Koln, Campus Gummersbach zu entwickeln.

Aufbauend auf den Erkenntnissen und Ergebnissen des Praxisprojektes
soll eine 3D Szene eines Aulenbereichs erstellt werden und anhand
dessen, die verschiedenen Madglichkeiten aufgezeigt werden, ein
fotorealistisches Rendering zu erreichen. Die Szene soll einen kleinen See
mit angrenzender Landschaft zeigen. Zur Erfullung dieser Aufgabe wird
die Szene mit der 3D Visualisierungssoftware ,Maya“ [MAY06] der Firma

Autodesk gestaltet.

2.2 Anforderungen an die Arbeit

Ziel dieser Arbeit ist es, Produktionsprozesse des ,Photorealistic Exterior*
Designs im Hinblick auf die Erstellung einer virtuellen Aufienszene zu
beschreiben. Jeder dieser Prozesse beinhaltet Problemstellungen, welche
beschrieben und gelost werden. Vorgange der Natur werden beobachtet,
analysiert und auf die Moglichkeit der Reproduktion in 3D — Applikationen
untersucht. Diese Kenntnisse werden in einer praktischen Arbeit bei der
Erschaffung einer virtuellen Szene, bestehend aus einem kleinen Teich

und der umgebenden Vegetation, angewendet.



Vorgange des Erstellens der Szene werden im Detail beschrieben und mit
Bildern versehen. Da sich meistens mehrere Moglichkeiten bieten das
gewunschte Ziel zu erreichen, werden die verschiedenen Techniken
miteinander verglichen und aufgezeigt, welche Vor- und Nachteile sie

jeweils bieten.

2.3 Aufbau der Arbeit

Der Aufbau dieser Arbeit beginnt mit einer Einflhrung zum Thema
Fotorealismus. In Kapitel 2.1 wird die genaue Themenstellung erlautert,
welche die Vorgehensweise bei der Erstellung des fotorealistischen
AulRenbereichs beinhaltet. In Kapitel 2.2 werden die Anforderungen fur
eine erfolgreiche Erfullung der Aufgabe festgelegt. Kapitel 2.3 erlautert
den Aufbau und die Strukturierung der Arbeit.

In Kapitel 4.1 werden die wichtigsten Modelling-Verfahren vorgestellit.
Anhand von Polygon-Modelling erfolgt in Kapitel 4.2 die Modellierung des
Gelandes. Kapitel 4.3 und 4.4 erklaren anhand verschiedener Ansatze die

Modellierung der Vegetation an den Beispielen von Gras und Baumen.

Nachdem die Modellierung der Szene in Kapitel 4 behandelt wurde,
beschreibt Kapitel 5 die Beleuchtung der Szene. Nach einer kurzen
EinflUhrung in Kapitel 5.1, werden die Anforderungen an die Beleuchtung
in Kapitel 5.2 festgelegt. Es folgt in Kapitel 5.3 eine Gegenuberstellung
verschiedener Lichtquellen. Kapitel 5.4 fuhrt den Begriff der lokalen
Beleuchtungsmodelle ein und zeigt, wie diese in Maya Verwendung
finden. Aufbauend auf den lokalen Beleuchtungsmodellen behandelt
Kapitel 5.5 die globalen Beleuchtungsmodelle. Es werden die
Anforderungen an die globale Beleuchtung festgehalten und mehrere
Verfahren miteinander verglichen. Diese werden erst theoretisch

behandelt und dann anhand einer Beispielszene in Maya eingesetzt.

Kapitel 6 behandelt die Texturierung des Gelandes und die Erstellung
komplexer Materialien. In Kapitel 6.2 werden unterschiedliche Mapping

Techniken erklart. Der Einsatz wird anhand von Beispielen in Maya



verdeutlicht. Das in Kapitel 4.2 erstellte Gelande wird anschliel3end in
Kapitel 6.4 texturiert. Danach erfolgt in Kapitel 6.5 und 6.6 die

Reproduktion von Wasser und Wolken.

In Kapitel 7 wird der Renderingprozess behandelt. Nach einer kurzen
EinfUhrung in Kapitel 7.1 wird in Kapitel 7.2 auf die Optimierung der Szene
eingegangen. Hiernach erfolgt in Kapitel 7.3 ein Vergleich der zur
Verfligung stehenden Renderer. Kapitel 7.4 behandelt abschlieRend die
gewahlten Rendereinstellungen und geht dabei auf Besonderheiten und
Optimierungen ein. Kapitel 8 beinhaltet die fertigen Renderings und eine

Beschreibung der Szene.

Im letzten Kapitel 9.1 wird ein Fazit der gesamten Arbeit gegeben.
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3 Grundlagen

Dieses Kapitel soll den Begriff Fotorealismus erklaren und dem Leser
dabei helfen, diesen Begriff fir die vorliegende Arbeit richtig einzuordnen.
Es wird kurz auf die Geschichte des Fotorealismus eingegangen und
dessen Bedeutung am Beispiel der Computerspiel - Industrie erklart.
Abschlielend erfolgt eine kurze Beschreibung fur die verwendete

Animationssoftware Maya.

3.1 Der Begriff Fotorealismus

Der urspriingliche Begriff des Fotorealismus entstand in den spaten 60er
Jahren und beschreibt ,eine Richtung der zeitgendssischen Kunst, fur die
eine reproduzierende Darstellung, die sich unmittelbar einer fotografischen
Vorlage bedient, charakteristisch ist [BHA02“]. Die Motivation eines
Fotorealisten bestand darin, immer realistischere Bilder zu Malen. Als
Vorlagen dienten den Kiinstlern meist ein Diapositiv® mit alltaglichen

Motiven aus ihrer Umwelt.

Abbildung 1: Fotorealismus in der Kunst [FOT]

3Ein Diapositiv oder Diafilm bezeichnet einen fotografischen Film, der Farben in seiner
nattrlichen Ansicht zeigt.
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In der Computergrafik kommt dem Begriff des Fotorealismus jedoch eine
andere Bedeutung zu. Wo in der Kunst ein Foto als Vorbild dient, nimmt in
der Computergrafik die Realitat diese Rolle an. Mit anderen Worten:
Fotorealismus in der Computergrafik ist die mdglichst detailgetreue
Nachbildung der Realitat unter Einhaltung ihrer physikalischen Gesetze
und Effekte.

Abbildung 2:  Fotorealismus in der Computergrafik [WIT]

Vor allem in der Computerspiel-Industrie nimmt der Fotorealismus eine
immer gro3er werdende Rolle ein. Durch die Weiterentwicklung von
Algorithmen, Vertex*- & Pixelshadern®, Graphics Processing Unit (GPU)
Leistung und der verwendeten Modelling-Tools, wurde seit Beginn der
90er Jahre eine enorme Qualitatssteigerung erreicht. Die Grinde fur diese
Entwicklung sind bei der Wahrnehmung des Menschens zu suchen: Die

visuelle Perzeption ist der wichtigste Sinn des Menschens. Daraus folgt,

* Programme, die von der GPU ausgefihrt werden. Sie haben die Aufgabe, die
Geometrie der Szene zu manipulieren.[VXS]

® Programme, die von der GPU ausgefiihrt werden. Sie haben die Aufgabe, die zu
rendernde Fragmente zu verandern.[PXS]
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dass Grafik die wichtigste Komponente der Immersion® darstellt. Fiir die
Computerspiel-Industrie  ist  Grafik somit das offensichtlichste

Verkaufsargument.

3.2 Das Programm Autodesk Maya

Das Programm Maya der Firma Autodesk ist eine professionelle und sehr
verbreitete 3D-Visualisierungs- und Animationssoftware. Die aktuelle
Version ist Maya 2009 (Erscheinungstermin August 2008). Maya setzt auf
eine offene Architektur, welche es dem Benutzer erlaubt, das Programm
auf seine Bedurfnisse anzupassen. Es ist modular aufgebaut, so dass sich
unterschiedliche Programmpakete ein- und ausschalten lassen. Zum
Beispiel lassen sich mit ,Maya Fur“ Haarflachen, Fell und Gras simulieren
oder mit Maya ,nCloth“ Kleidungsstlicke oder Stoffstiicke simulieren.
Bekannte Beispiele aus der Unterhaltungsindustrie, welche mit Hilfe von
Maya entwickelt wurden, sind Filme wie ,Shrek®, ,der Herr der Ringe“ oder
,Fluch der Karibik“ (Abbildung 3). [AUT]

Abbildung 3 : Mit Maya erstellte Figuren in Kinofiimen: (links) ,Davy Jones* aus ,Fluch der
Test Karbik®, (rechts) ,Gollum* aus ,der Herr der Ringe“. [WAB]

¢ Der Begriff Immersion beschreibt im Kontext der virtuellen Realitat das Eintauchen in
eine kinstliche Welt. [[IMM]
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4 Modellierung

Nachdem grundlegende Begriffe und Erlduterungen in Bezug auf
Fotorealismus beschrieben wurden, wird in diesem Kapitel detailliert auf
die Modellierung der Szene eingegangen. Die Modellierung stellt dabei
den ersten Schritt in Richtung eines fotorealistischen Aulienbereichs dar.
Zu Beginn des Kapitels werden grundlegende Begriffe wie Polygone und
NURBS’ erklart und deren Relevanz hinsichtlich der Modellierung
verdeutlicht. Danach wird die Erschaffung der einzelnen Objekte der
Szene wie Baume, Gras und Gelande detailliert beschrieben und

aufgezeigt welche Moglichkeiten der Modellierung sich anbieten.

4.1 Grundlagen der Modellierung

Unter dem Begriff Modellierung versteht man den Vorgang des Formens
und Gestaltens. Maya bietet hierflr drei Modellierungstechniken an: das
NURBS-Modelling, das Polygon-Modelling und das Subdivision-Modelling
(Abbildung 4).

Erzeugte Kugeln mit NURBS-Modelling, Polygon-Modelling und
Abbildung 4
Subdivsion-Modelling.

" Non Uniform Rational B-Splines®, Vgl Kapitel 4.1.2
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Je nach Aufgabenstellung und Anforderung eines Projektes sollte sich fur
eine dieser drei Modellierungstechniken entschieden werden. Hierbei gilt
es, sich die jeweiligen Vorteile der einzelnen Techniken zu Nutze zu
machen. Es folgt nun eine kurze Beschreibung der einzelnen

Modellierungstechniken.

4.1.1 Polygone

'Polygone' sind Vielecke. ,Sie sind durch eine Gruppe geordneter
Polygonpunkte, sogenannter Vertices, und zum anderen durch ihre
Kanten, die Edges, die die Vertices verbinden, gekennzeichnet‘ [MAYQ7,
S. 154]. Eine Polygonflache kann minimal durch drei Punkte erzeugt
werden, an denen sich die Flache aufspannt. In diesem Fall spricht man
von einer triangularen Form. Bei vier Eckpunkten spricht man hingegen
von Quads. Bei der Modellierung bieten sich quadratische Flachensticke
eher an, da sie einen besseren Uberblick Uber die Geometrie geben und
einfacher zu handhaben sind. Im Gegensatz zu NURBS werden Polygone
nur linear interpoliert, sie stellen eine lineare Verbindung der einzelnen
Punkte dar. Um weiche Rundungen mit Polygonen zu erhalten, mussen
entsprechend viele Unterteilungen vorgenommen werden. Polygon-
Modelling bietet sich vor allem fur architektonische Darstellungen an (Vgl.
[PRPY]).

4.1.2 NURBS

Non Uniform Rational B-Splines werden kurz NURBS genannt. NURBS
werden durch ihren Grad, ihre Kontrollpunkte und ihren Kontrollvektor
definiert. Durch Interpolationsfunktionen werden Kurven beschrieben, die
durch gegebene Punkte fuhren [ECG96, S. 102]. Der Vorteil, den NURBS
bieten, ist, dass man mit nur wenigen Punkten weiche Kurvenziuge

erhalten kann. Nachteilig wirkt sich aus, dass fur eine feine Unterteilung
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jeweils immer Isoparms® eingefiigt werden missen. Diese Isoparms
ziehen sich Uber das gesamte Modell und bringen hohe Unterteilungen
auch dort, wo sie nicht gebraucht werden. Hauptsachlich finden NURBS
in der computergestutzten Konstruktion (CAD) Verwendung. In der 3D -
Modellierung bieten sich NURBS immer dann an, wenn man es mit

organischen Objekten mit weichen Oberflachen zu tun hat.

Abbildung 5 Anatomie einer NURBS-Kurve [DMA]
4.1.3 Subdivision Surfaces

Ein Subdivision Surface beschreibt ,eine iterative Methode zur Erzeugung
glatter Oberflichen aus groben vorgegebenen ,Kontroll-Meshes®*
[MAYO07]. Subdivision Surfaces vereinigen die Vorteile von Polygon- und
NURBS-Modelling. Wie NURBS-Modelle, werden sie weich interpoliert,
konnen aber auch wie Polygon-Modelle partiell verfeinert werden.
Subdivision Surfaces vereinigen also die Vorteile von NURBS und
Polygonen und umgehen weitestgehend ihre Nachteile. Organische
Formen kdnnen demnach sehr gut mittels Subdivision Surfaces modelliert

werden. Technische Korper hingegen, die ein Hochstmal® an Prazision

8 |soparms sind strebenartige in U- oder V-Richtung gerichtete Komponenten einer
NURBS Flache.

° Meshing bezeichnet eine Gruppe von Verfahren in der Computergrafik. Hierbei wird
eine z. B. mathematisch gegebene Oberflache durch eine Menge kleinerer, meist ebener
Elemente angenahert (approximiert). Am haufigsten kommen hier Dreiecks- oder
Viereckselemente zur Anwendung.” [MES]
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erfordern, werden in der Regel weiterhin GUber NURBS oder Polygone

erzeugt.

4.2 Modellierung des Gelandes

Dieses Kapitel beschreibt die Modellierung des Gelandes. Zu Beginn
werden die Anforderungen an die Modellierung festgelegt. Danach erfolgt
die Umsetzung zweier Ansatze in Maya, welche detailliert beschrieben
werden. Zum Abschluss wird das Ergebnis mit den Anforderungen

abgeglichen.

4.2.1 Anforderungen an das Gelande

In der Natur finden sich eine Vielzahl von unterschiedlichen Gelandearten
wieder. Die Geometrie dieses Gelandes gilt es so detailliert wie moglich
nachzumodellieren. Abhangig von der Art des Gelandes ergeben sich
typische Charakteristika, die es zu berlcksichtigen gilt. Zum Beispiel
befinden sich Seen und Flisse in abgesenkten Bereichen des Gelandes,
oder Gebirge bestehen aus vielen unterschiedlich hohen und verformten

Bergen.

4.2.2 Verwendete Ansatze und Techniken

Auf der ,SIGGRAPH 2004: The Elements of Nature stellte F. Kenton
Musgrave eine Technik zur Erstellung von realistischen Gebirgen mittels
Fraktalen vor [SIG04]. Dieser Ansatz wird in etwas abgeanderter Form
auch in Maya eingesetzt und erklart, wie sich damit realistische
Gebirgsketten modellieren lassen. Der zweite Ansatz verfolgt das Ziel, mit
einfachen Mitteln, geometrisch weniger anspruchsvolle Gelande als

Gebirge zu modellieren.
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4.2.3 Umsetzung der Techniken in Maya

Zur Modellierung eines Gelandes (Terrain) bietet Maya dem Benutzer
verschiedene Moglichkeiten an. Je nach Anforderungen und
Aufgabenstellung bieten sich verschiedene Ansatze an, das Problem zu
I6sen. Die Basis fur die Modellierung bildet fir die vorgestellten Techniken
immer eine NURBS- oder Polygon-Ebene. Bevor auf die Modellierung der
eigentlichen Szene eingegangen wird, erfolgt ein kurzer Einblick in die
Modellierung eines Gebirges nach dem Ansatz von Musgrave [SIG04].
Dieser Ansatz soll die unterschiedlichen Herangehensweisen an ein

Problem bezuglich der Anforderungen verdeutlichen.

Um ein Gebirge zu modellieren, erstellt man im Hypershade-Editor™ ein
,Height-Field“, welches als Displacement (Vgl. Kapitel 6.2.3) eine Noise"
Textur erhalt. Die Noise-Textur wird nun Uber die verschiedenen
Einstellungsmdglichkeiten den Bedlrfnissen angepasst. Das ,Height
Field“ dient dem Benutzer in diesem Fall nur als Vorschau fur die

Gelandestruktur.

Abbildung 6  (links) modelliertes Gebirge, (rechts) Shading Netzwerk

' Ein Fenster zum Erstellen, Editieren und Verbinden von Rendering Knoten, wie
Texturen, Materialien, Lichtquellen oder Special Effects [MAD]

" Gibt eine Zufallszahl zwischen -1 und 1 gemaR eines Perlin Noise Feld Generators
aus. Er bietet sich fir die Erstellung prozeduraler Texturen an [ATLO6]
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Nun wird ein neuer Shader fir das Gelande erstellt und dieser mit der
erzeugten Noise Textur als Displacement verknlpft. Letztlich wird die
Displacement Map Uber ,Modify > Convert > Displacement To Polygons*®
in eine Polygonflache konvertiert (Abbildung 6). Mit Hilfe dieses
Verfahrens kdnnen nicht nur Gebirge realistisch modelliert werden. Durch
die komplexen Einstellungsmoglichkeiten der Noise-Textur ist es auch

moglich, Strukturen wie Dunen oder Wasseroberflachen zu erzeugen.

Das Verfahren, Oberflachenstrukturen Uber eine Displacement Map zu
erzeugen, bietet sich vor allem dann an, wenn man topografisches'
Kartenmaterial verwenden will. So lassen sich, abhangig von der Qualitat
des verwendeten Kartenmaterials, realistische HoOhenunterschiede

darstellen.

FUr die Erstellung der Szene, die einen See und die angrenzende
Landschaft zeigt, ist diese Technik jedoch nur bedingt vorteilhaft. Da das
Gelande nahezu flach ist und nur geringe Hohenunterschiede vorhanden
sind, bietet sich die Modellierung uber das ,Sculpt Geometry Tool* an. Mit
diesem Werkzeug ist es moglich, Uber einen Pinsel die einzelnen Control
Vertices™ (NURBS) oder Vertices (Polygone) hinein- oder
herauszudrucken. Dadurch lassen sich mit einfachen Mitteln individuelle

Oberflachen modellieren.

Zuerst wird eine Polygonflache erstellt und Uber die ,/Inputs® die
Unterteilungen der Flache (,width® und ,height‘) eingestellt. Eine hohe
Anzahl an Unterteilungen ist wichtig, um das Gelande im Folgenden
moglichst genau verformen zu kdnnen. Jetzt wird die Polygonflache Uber
.Polygons > Mesh > Sculpt Geometry Tool“ bearbeitet. Die Vertices

werden Uber die Pinselspitze, welche in der GroRe verstellbar ist, hinein-

2 Die Topografie ist ein Teilgebiet der Kartografie, die sich mit der Vermessung,
Darstellung und Beschreibung der Erdoberflache und der mit dieser fest verbundenen
nattrlichen und kinstlichen Objekte befasst.” [BHA02]

3 In der 3D-Computergrafik ist ein Vertex (Mz. Vertices) ein Eck- bzw. Scheitelpunkt
eines Primitivs [MAY07]
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oder herausgedriickt. Scharfe Kanten kénnen Uber die ,smooth® oder
orelax‘ Funktion angeglichen werden. Nachdem die Flache fertig
bearbeitet ist, wird sie uber ,Polygons > Mesh > Smooth* noch feiner
unterteilt, um einen hoheren Detailgrad des Gelandes zu erreichen
(Abbildung 7). Das Gelande ist jetzt fertig modelliert.

Abbildung 7 (links) modelliertes Terrain, (rechts) modelliertes Terrain mit ,smooth*

4.2.4 Abgleich mit den Anforderungen

Die Modellierung eines Gelandes ist ein Vorgang der mal3geblich von den
Anforderungen abhangt, die das zu modellierende Gelande mit sich bringt.
Abhangig von der Gelandeart bieten sich manche Verfahren besser an,
manche schlechter. Nach diesem Kapitel kann man festhalten, dass es
kein ,ultimatives® Schema gibt, mit dem jede Gelandeart effizient
modelliert werden kann. Fur die Erstellung eines Gelandes, welches einen
See und angrenzende Vegetation zeigt, bietet sich die Modellierung Uber
das ,Sculpt Tool* an, wodurch man individuell auf die Anforderungen des

Gelandes eingehen kann.
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4.3 Reproduktion von Gras

Nachdem das Geléande thematisch behandelt wurde, befasst sich dieses
Kapitel mit der Modellierung von Gras. Zu Beginn des Kapitels wird ein
Blick auf die Eigenschaften von Gras geworfen und damit die
Anforderungen festgelegt. Danach werden die Maya Module ,Paint
Effects” (PaintFX) und ,Fur® kurz erlautert. AnschlieBend erfolgt die
Modellierung des Grases. AbschlieRend werden die beiden Techniken

verglichen und Vor- sowie Nachteile aufgezeigt.

4.3.1 Eigenschaften von Gras

Um realistisches Gras zu modellieren muss man verstehen, wie Gras in
der Wirklichkeit aussieht (Abbildung 8).

Abbildung 8 Foto: Gras [LEF]

Betrachtet man das Bild genauer, lassen sich mehrere Charakteristika
festlegen. Das Gras weist viele verschiedene Farben, GroRen und Arten
auf. In der Wirklichkeit tritt niemals nur eine Sorte von Gras auf. In der
Grasflache finden sich immer verschiedene Sorten Pflanzen wie Blumen,
Unkraut oder abgestorbenes Gras. Um also naturgetreues Gras zu
modellieren, bedarf es dem Einsatz mehrerer verschiedener Grassorten.
Aulerdem muss die GroRe und die Farbe der einzelnen Grashalme

variieren.
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Abbildung 9  Unterschiedlicher Schattenwurf einer Grasflache [CGT]

In Abbildung 9 bemerkt man aullerdem die unterschiedlichen
Schattenflachen: Die Spitzen der Grashalme bekommen viel Licht, wobei
am Boden nur wenig Licht ankommt und uneinheitliche Schattenflachen
entstehen. Jeder Grashalm wirft einen Schatten auf den Boden und zu
benachbarten Grashalmen. Das Resultat ist, dass wenig Licht am Boden
ankommt. Um ein fotorealistisches Rendering einer Grasflache zu
erhalten, ist es also nétig, viel Kontrast zwischen Spitze und Boden des

Grases zu erzeugen.

4.3.2 Maya Paint Effects

Paint Effects ist eine Komponente von Maya, mit der man
zweidimensionale Bilder oder Texturen zeichnen kann. Sie besitzen keine
Geometrie aus Polygonen, NURBS oder ahnlichem, sondern bestehen
aus Strichen. ,Mit einfachen Pinselstrichen kdnnen komplexe Strukturen
wie zum Beispiel Blumen oder Olfarben auf einem Bild oder mit dem
.Paint 3D Tool* sogar auf Oberflachen einer Geometrie aufgetragen
werden [MAO7, S. 366].“ Maya bietet fur realistische Strukturen wie

Pflanzen, Haare, Feuer, Federn, Pastelle, Wasserfarben, etc. eine
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Vielzahl von vorgefertigten Pinselwerkzeugen an. Diese kdnnen Uber den

.Paint Effects Visor* aufgerufen werden.

.Paint Effects werden Uber ,Strokes® (Striche) aufgetragen. Ein Paint
Effects Stroke ist eine untergeordnete NURBS-Kurve. Die Ausrichtung der
Kurve bestimmt die Form der Paint Effects Struktur, die entlang der Kurve
erzeugt wird [MAOQ7, S. 367].“ Maya Paint Effects kdnnen nicht von Mental
Ray (Vgl. Kapitel 7.3) gerendert werden. Wer auf den Einsatz von Mental
Ray nicht verzichten kann, muss die Paint Effects vorher in Polygone oder
NURBS konvertieren.

Abbildung 10 Beispielszene mit Paint Effects

4.3.3 Maya Fur

Neben den Paint Effects bietet sich ein zweiter Ansatz flr die Modellierung
von Gras an: Maya Fur. Maya Fur (Ubersetzt: Fell) ist ein Maya Plugin
zum Erstellen realistischer Felle und Haare. Neben verschiedener
Voreinstellungen fur Bisonfell, Labradorfell, Dreadlocks oder Punkfrisur
bietet Maya Fur auch eine Einstellung fir Gras an. Uber das ,Paint Fur

Attributes Tool“ ist es moglich, direkt in der Szene uber einen Pinsel die
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Fur-Objekte individuell in GroRe, Lange oder Drehung zu verandern.
Szenen mit Maya Fur werden effizient vom Maya Software Renderer (Vgl.
Kapitel 7.3.1) gerendert. Mental Ray unterstutzt ebenfalls das Rendern
von Fur-Objekten, ist jedoch aufgrund der internen Umwandlung der Fur-

Objekte in eine Geometrie deutlich langsamer.

Maya Software (0:03 min) Mental Ray (3:52 min)

Maya Software (0:02 min) Mental Ray (2:47 min)
Abbildung 11 (oben) Maya Fur Kugeln, (unten) bearbeitete Maya Fur Kugeln

4.3.4 Umsetzung der Techniken in Maya

Wie bereits im Kapitel 4.3.1 ,Eigenschaften von Gras" angesprochen, geht
es darum, die Charakteristika von Gras moglichst genau nachzubilden.
Maya Paint Effects bieten sich flr diese Aufgabe besonders gut an, da sie
eine Vielzahl von Einstellungsmdglichkeiten besitzen, das Objekt den
Bedurfnissen anzupassen. Die Erstellung von Gras mit Paint Effects ist ein

sehr experimenteller Prozess. Durch die Vielzahl von Einstellungen muss
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eine zeitintensive ,Trial and Error'*“ Phase durchlaufen werden, bis man

mit dem Ergebnis zufrieden ist.

Um ,Paint Effects® auf das modellierte Gelande zu ,malen®, muss das
Gelande ,paintable” sein. Das bedeutet, dass die Paint Effects auf dem
Drahtgitter der Polygonflache platziert werden und nicht darunter oder
dariber. Dies geschieht Uber ,Rendering > Paint Effects > Make
Paintable®. Zu Beginn wird nur ein kleiner Teil mit Gras ,bepflanzt®. Dies
geschieht, weil die Renderzeiten sonst zu hoch waren. Spater kdnnen die
Pinseleinstellungen dann Gbernommen werden (share one Brush) und das

Gelande grof¥flachig mit Gras besetzt werden.

Zuerst wird Uber den ,Paint Effects Visor* ein Pinsel ausgewahlt und
anschliefend auf der Polygonflache ein kleines Stuck Gras aufgetragen.
AnschlielRend wird die Szene gerendert (Abbildung 12). Das Ergebnis ist
nicht realistisch: die einzelnen Grashalme sind zu breit und zu einheitlich.
Die Form der Grashalme muss sich besser voneinander abheben und die
Halme mussen in der Spitze dinner zusammenlaufen. Bevor die Form
nun aber weiter bearbeitet wird, werden vorher die Farben angepasst.
Dies bietet sich an, weil man an den breiten Grashalmen die veranderten

Farben besser erkennen kann.

Abbildung 12 (links) Standard Farben, (rechts) angepasste Farben

" Versuch und Irrtum ist eine heuristische Methode, um Probleme zu l6sen, bei denen so
lange zulassige Lésungsmoglichkeiten ausprobiert werden, bis die gewlinschte Lésung
gefunden wird. [BHAOQ2]
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Nun wird die Form der Grashalme Uberarbeitet. Angefangen von der
eigentlichen Grasdicke werden darlber hinaus noch weitere Attribute der
Blatter, Abzweigungen und Segmente verandert. Auf die verschiedenen
Einstellungsmoglichkeiten wird an dieser Stelle nicht naher eingegangen,
da es sich, wie schon erwahnt um einen sehr experimentellen Prozess
handelt und die Attribute je nach Anforderung an das Projekt stark
variieren. Uber den ,Paint Effect Visor* wird nun die gleiche Grasart erneut
ausgewahlt und groRflachig in der Szene aufgetragen. Uber die ,Share
One Brush“ Funktion werden die Pinseleinstellungen Gbernommen. Dieser

Prozess wird fur einen zweiten Grastypen wiederholt (Abbildung 13).

Abbildung 13 Maya Paint Effects Gras — Final Rendering

Nachdem die Reproduktion von Gras mit Paint Effects bereits sehr gute
Ergebnisse geliefert hat, beschreibt der zweite Ansatz die Modellierung
mit Hilfe von Maya Fur. Um mit Maya Fur realistische Ergebnisse zu
erzielen, bedarf es der Einhaltung derselben Kriterien wie bei der
Modellierung durch Paint Effects. Zu Beginn wird die Polygonflache
ausgewahlt, welche mit Gras bepflanzt werden soll. Nun wird Uber

.,Rendering > Fur > Attach Fur Description > New" die Flache mit Fur
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besetzt. Das erstellte Fur wird selektiert und Uber ,Presets > Grass >

Replace“ die Voreinstellungen fur Gras geladen.

Abbildung 14 Maya Fur Voreinstellungen fiir Gras

Das erste Rendering ist im Hinblick auf Fotorealismus wenig
Uberzeugend. Die einzelnen Grashalme sind zu breit und zu einheitlich.
Bevor die Form nun bearbeitet wird, werden wie bei den ,Paint Effects"
zuerst die Farben angepasst. Nachdem diese auf die Szene abgestimmt
sind, wird das Gras kleiner skaliert und die Grasdichte um das zehnfache
erhoht. Im Gegensatz zu Paint Effects bietet Maya Fur nur eine Art von
Gras an. Um trotzdem mehrere Arten von Gras zu simulieren, wird das
Fur Gras mehrmals dupliziert. Durch Anderung von Farbe, GréRe und
Verdrehung kénnen so verschiedene Grasarten erstellt werden. Der
Nachteil gegenuber den Paint Effects besteht darin, dass keine anderen
Formen erzeugt werden konnen. Fur die Erstellung der Beispielszenen
wurden drei verschiedene ,Fur-Grasarten“ erstellt. Die fertig modellierte
Szene wurde zum Vergleich mit Maya Software Renderer (Abbildung 15)
und Mental Ray (Abbildung 16) gerendert. Maya Software Renderer
braucht fur die Berechnung der Szene 0:12 Minuten, Mental Ray bendtigte

hingegen 47:45 Minuten.
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Abbildung 15 (links) Maya Software Rendering, (rechts) Mental Ray Rendering

4.3.5. Vergleich Paint Effects / Fur

Die vorangegangen Kapitel haben gezeigt, dass es madglich ist, mit Paint
Effects und Fur fotorealistische Ergebnisse von Gras zu erzielen. Dieses
Kapitel soll die Vor- und Nachteile der beiden Plugins im Bezug auf die
Modellierung von Gras gegenuberstellen und klaren, fur welche Szenen

sie sich anbieten.

Maya Paint Effects bieten durch die vielen verschiedenen Arten und
Einstellungsmdglichkeiten eine sehr individuelle Gestaltung der Szene. Im
Gegensatz zu Maya Fur ist es mit ihnen mdglich, sehr speziell auf die
Anforderungen der Szene zu reagieren. Voreinstellungen fur Schilf,
Feldgras, Dschungelgras oder Kakteen ermoglichen die Gestaltung jedes
erdenklichen Szenarios. Die vielen Einstellungsmoglichkeiten garantieren
einen hohen Detailgrad des erstellten Objektes, so dass sich auch
EinstellungsgroRen™ wie GroRaufnahmen oder Detailaufnahmen zum

Rendern eignen.

Maya Fur bietet sich dann an, wenn man grolRe, gleichmallige
Grasflachen modellieren mdchte. Zwar ist es mdglich, Uber das ,Paint Fur

Attributes Tool* die Grasflache in Lange oder Dichte zu verandern, im

'® In der Filmkunst eine Angabe lber den im Bild gezeigten Ausschnitt. Hier im Bezug auf
Rendering.[BHAO02]
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Vergleich zu Paint Effects sind die Maoglichkeiten jedoch stark
eingeschrankt. Im Hinblick auf Fotorealismus ist der Detailgrad bei
GroRaufnahmen nicht ausreichend. Die Starken von Maya Fur liegen vor
allem in den realistischen Schatten, die die Fur Objekte werfen. Somit
bietet es sich an, Maya Fur immer dann zu verwenden, wenn grolde

Grasflachen mit totalen Einstellungen gefordert sind.

4.3.6 Abgleich mit den Anforderungen

Das Kapitel hat gezeigt, dass es mdglich ist, mit Paint Effects und Fur
fotorealistisches Gras zu erzeugen. Inwieweit es jedoch fotorealistisch
erscheint, hangt stark von der verwendeten Einstellungsgrofie ab.
AbschlielRend lasst sich festhalten, dass die Anforderungen an das Gras
auf realistischen Schattenwurf (Abbildung 15) und unterschiedliche Farben

und Formen (Abbildung 13) erflllt werden.

4.4 Reproduktion von Baumen

Nachdem die Modellierung von Gras abgeschlossen ist, befasst sich
dieses Kapitel mit der Modellierung von Baumen. Auch hier werden zu
Beginn die Merkmale von Baumen beschrieben und erklart worauf bei der
Modellierung zu achten ist. Danach erfolgt die Modellierung eines Baumes
mit Paint Effects. Anhand eines kleinen Exkurses wird die Erstellung von
dreidimensionalen fotorealistischen Modellen anhand der Bild-basierten
Modellierung erklart. Abschlielend erfolgt eine Zusammenfassung der

Ergebnisse und ein Abgleich mit den Anforderungen.

4.4.1 Eigenschaften von Baumen

Um einen Baum realistisch zu modellieren, muss man versuchen, die
physikalischen Eigenschaften madglichst genau in Maya umzusetzen.

Form, Farbe und Detailgrad mussen der Realitdt entsprechen, um
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fotorealistische Renderings zu erzeugen. Wie Abbildung 16 zeigt, besteht
ein Baum aus einem Baumstamm, Asten, Zweigen und Blattern. Beim
Baum mussen zwei verschiedene Materialien unterschieden werden: Holz
bzw. Baumrinde und die Blatter. Diese unterscheiden sich deutlich in ihrer
Art das Licht zu reflektieren. Wenn man einen genauen Blick auf die
Blatter wirft, bemerkt man, dass die Blatter nicht komplett grin sind,
sondern ein Mix aus grin und orange aufweisen. Die orangene Farbung
wird durch die direkte Sonneneinstrahlung erzeugt. Die hohe Anzahl von
Blattern sorgt daflr, dass nur wenig Licht ins Innere der Baumkrone

gelangt.

Abbildung 16  Foto: Baum [PHH]

4.4.2 Umsetzung der Techniken in Maya

Zu Beginn muss die Polygonflache ,Paintable“ gemacht werden. Danach
wird Uber den ,Paint Effects Visor* der gewlnschte Pinsel fir Baume
ausgewahlt. Maya bietet hierfir circa dreizig verschiedene
Voreinstellungen an. Angefangen bei Birken, Eichen und Ahorn Uber

Palmen und Pinien lassen sich Szenarien wie Walder, Wiuisten und
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Strande gestalten. Fir die folgende Beispielszene wird die Voreinstellung

fur Eiche verwendet.

Abbildung 17  Maya Paint Effects Eiche

Maya Paint Effects bieten auch bei Baumen eine Vielzahl von
Einstellungen. Neben diversen Farb- und Beleuchtungsanpassungen ist
es moglich, Form und Anzahl von Stamm, Zweigen und sogar Blattern zu
verandern. Dem Benutzer wird dadurch die Maoglichkeit gegeben, vollig
neue Baumkreationen zu entwerfen. Wenn man Abbildung 17 betrachtet,
stellt man fest, dass der Baum in der Szene wie ein Fremdkdrper wirkt. Es
ist nétig, noch einige Anpassungen an Farbe und Form vorzunehmen. Wie
bei der Modellierung von Gras geschieht dies Uber einen ,Trial and Error®
Prozess. Die fertig modellierte Szene wird nun wiederum mit Maya
Software Renderer und Mental Ray gerendert. Maya Software bendtigt fur

die Szene 0:18 Minuten zum rendern, Mental Ray 35:26 Minuten.
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Abbildung 18  Maya Paint Effects Eiche, Maya Software Rendering

Abbildung 19  Maya Paint Effects Eiche, Mental Ray Rendering
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4.4.3 Bild-basierte Pflanzenmodellierung

Dieses Kapitel soll dem Leser zeigen, dass es neben der Modellierung mit
Maya noch weitere Ansatze gibt, fotorealistische Baume oder Pflanzen zu

erzeugen.

Aufgrund der komplexen geometrischen Struktur stellen Baume eine
grol’e Herausforderung dar, realistisch modelliert zu werden. Auch mit
Plugins oder eigenstandigen Softwareprodukten zur
Pflanzenmodellierung, wie Maya Paint Effects, ,TreeGenerator'® oder
,TreeFactory' lassen sich Uberzeugende Ergebnisse nur mit hohem
Aufwand realisieren. Aus wirtschaftlicher Sicht gilt es zu bedenken, dass
diese Produkte meist hohe Kosten mit sich ziehen. Das professionelle
,SpeedTreeCad“, welches von der ,Unreal Engine' verwendet wird,

kostet in vollem Umfang 6.400 Euro.

Bei der Bild-basierten Pflanzenmodellierung werden Pflanzen moglichst
detailgetreu durch Bilder nachgebildet. Neben der madglichst realistischen
Modellierung, besteht das Ziel, dem Benutzer mdglichst viele
Interaktionsschritte abzunehmen und somit Zeit zu ersparen. Ein weiterer
Vorteil besteht darin, dass im Gegensatz zur Modellierung in einer 3D
Animationssoftware keine genauen Kenntnisse uber die physikalischen
Eigenschaften von Pflanzen nétig sind. Aufgrund der hohen Komplexitat
des Themas und der ausreichenden Fachliteratur soll der Prozess der
Bild-basierten Pflanzenmodellierung nur oberflachlich behandelt werden.
Auf den mathematischen Hintergrund der Graphen-basierten

Blattextraktion und der Algorithmen wird nicht naher eingegangen.

Der Prozess der Bild-basierten Pflanzenmodellierung besteht im

Wesentlichen aus folgenden Schritten: Der Anfertigung von Fotos des

'® Software zur Erstellung von 3D Modellen von B&dumen. Export als .obj und .3ds [TRG]
7 Plugin ftr 3D Studio Max. Erstellung von 3D Modellen von Pflanzen. [TRF]

'8 Ein komplettes Entwicklungsgertst fur DirectX 10 bestlickte PCs, XBOX 360 und
Playstation 3.“ [UNR]
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Objektes, der Zweigrekonstruktion, der Graphenbasierten Blattextraktion
und letztlich der Blattrekonstruktion [ITMO7].

Zu Beginn werden Fotos des Objektes aus unterschiedlichen Winkeln
erstellt. Die Kamerabewegung um das Objekt wird nun rekonstruiert und
anhand dessen, die jeweilige Position des Objekts im Raum bestimmt. Die
daraus gewonnen Informationen werden zu einer dreidimensionalen

Punktwolke Uber einen Algorithmus am Computer umgewandelt.

Abbildung 20  (links) Ursprungsfotos, (rechts) erzeugte Punktwolke [ITMO07]

Die Zweigrekonstruktion stellt einen schwierigen Teil dar, weil bei vielen
Pflanzenmodellen nur ein geringer Teil der Zweige sichtbar ist. Hier gibt es
verschiedene Ansatze dieses Problem zu l6sen. Eine Losung besteht
darin, dass man dem Benutzer ein Werkzeug bereitstellt, mit dem er
ahnlich wie in einer 3D Animationssoftware die Zweige zu Full modellieren
kann. Andere Ansatze gehen den Weg, dass zuerst die sichtbaren Zweige
anhand der Fotos rekonstruiert werden und anschlie3end Uber eine nicht-

parametrische Textursynthese' die verdeckten Zweige generiert werden.

Auf Basis der Punktwolke wird nun ein ungerichteter, gewichteter Graph
aufgebaut. Die Punkte werden mit Hilfe der 3D und 2D Informationen in
Teilmengen zerlegt. Diese Teilmengen reprasentieren jeweils ein

einzelnes Blatt. Anhand von Algorithmen, die unter anderem die

' Die automatische Erzeugung von Texturen, also zweidimensionalen digitalen Bildern,
die Oberflachenstrukturen oder vergleichbare Inhalte zeigen“ [TES]



Bachelorarbeit Florian Gebauer

38

Farbanderung der benachbarten Pixel berechnen, werden die einzelnen
Blatter zu 3D Gruppen aufgeteilt. Probleme kdnnen bei der Extraktion an
Stellen auftreten, an denen sich Blatter sehr ahnlich sehen. Dadurch sind

die Grenzen zwischen den einzelnen Blattern nicht klar zu berechnen.

Abbildung 21 (links) Rekonstruierte sichtbare Zweige

(rechts) Uber Textursynthese erzeugte nicht sichtbare Zweige [ITM07]

Zum Schluss erfolgt die Blattrekonstruktion. Es muss eine Blatt-Textur
ausgewahlt werden, welche dann fir jede Gruppe von 3D Punkten an die
passende Koordinate eingefligt und ausgerichtet wird. Die Blatter werden
nun gemaly der Informationen uber ihre GroRe erstellt. Liegt keine
Information Uber die GroRRe vor, so wird die Grof3e eines vordefinierten
Blattes Ubernommen. Zuletzt werden die Farbinformationen aus den

Ursprungsfotos den Blattern zugewiesen.

Abbildung 22  (links)Blattrekonstruktion, (rechts) texturiertes 3D Modell [ITM07]
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4.4.4 Vergleich Paint Effects / Bild-basierte Modellierung

Die letzten beiden Kapitel haben gezeigt, dass es mdglich ist, mit vollig
verschiedenen Methoden, fotorealistische Baume bzw. Pflanzen zu
modellieren. Auf der einen Seite steht die klassische Modellierung Uber
eine 3D Animationssoftware, auf der anderen Seite die Generierung von
3D Modellen Uber Fotos. Die Vor- und Nachteile dieser Verfahren werden

an dieser Stelle zusammengefasst.

Die Modellierung von fotorealistischen Baumen mit Maya Paint Effects
stellt einen komplizierten und zeitaufwandigen Prozess dar. Ohne
ausreichende Kenntnisse Uber die physikalischen Eigenschaften von
Baumen ist es nicht moglich, das Ziel zu erreichen. Aullerdem ist es
nahezu unmdglich, einen Baum von einer Vorlage eins zu eins
nachzubilden. Den groRen Vorteil den die Paint Effects Modellierung
gegenuber der Bild-basierten Modellierung hat, ist die einfache
Realisierung von Szenen mit einer grolen Anzahl von

Vegetationsobjekten.

Die Bild-basierte Modellierung von Pflanzen liefert Uberzeugende,
fotorealistische Ergebnisse. Abhangig von der Effektivitat der Algorithmen
und der Qualitat der Ursprungsfotos, werden Form und Farben eins zu
eins nachgebildet. Es sind keinerlei Kenntnisse Uber die physikalischen
Eigenschaften nétig. Das grof3e Problem der Bild-basierten Modellierung
sind verdeckte Bereiche, die nicht direkt nachgebildet werden konnen. Bei
komplexen Gebilden wie Baumen, wo gro3e Teile der Blatter nicht
sichtbar sind, mussen komplizierte Verfahren, wie die nicht-parametrische
Textursynthese, herangezogen werden, die diese dann reproduzieren. Die
Bild-basierte Modellierung bietet sich immer dann an wenn Modelle eins
zu eins reproduziert werden sollen, wie dies zum Beispiel bei

architektonischen Projekten der Fall ist. Solange jedoch ein gewisser
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kreativer Freiraum vorhanden ist, bleibt die klassische Modellierung erste
Wahl.

4.4.5 Abgleich mit den Anforderungen

Dieses Kapitel hat gezeigt, dass die fotorealistische Reproduktion von
geometrisch-komplexen Gebilden  wie Baumen eine  grofRe
Herausforderung darstellt. Aufgrund der grofen Auswahl an kommerzieller
Software, die dieses Problem zu I6sen versucht, wurde in Maya nur der
Ansatz der Reproduktion mit Paint Effects verfolgt. Die Erstellung eines
eigenen realistischen Modells hatte zu viel Zeit gekostet und sehr
wahrscheinlich keine besseren Ergebnisse als der Paint Effects Baum
gebracht. Der modellierte Paint Effects Baum erfullt alle Anforderungen,
die in Kapitel 4.4.1 festgelegt wurden. Vor allem die Interaktion mit dem
Licht kann als auRerst gelungen bezeichnet werden (Abbildung 23).
Vergleicht man das zu Anfang gezeigte Referenzbild mit dem finalen

Rendering, so lassen sich nur Kleinigkeiten ausmachen.

Abbildung 23  Vergleich zwischen echtem (links) und nachgebildeten Baum (rechts)
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5 Beleuchtung

Nach der thematischen Behandlung der Szene in Bezug auf Modellierung,
beschreibt dieses Kapitel den zweiten Schritt in Richtung eines
fotorealistischen Aufllenbereichs. Zu Beginn des Kapitels werden die
Anforderungen festgelegt, die sich fir die Beleuchtung von einzelnen
Objekten und der gesamten Szene ergeben. Wichtige Begriffe werden
geklart und Mdglichkeiten aufgezeigt, wie sich verschiedene
Lichtsituationen mit Hilfe von Maya simulieren lassen. Danach werden
lokale und globale Beleuchtungsmodelle erklart und anhand von
Beispielszenen in Maya angewendet. AbschlieBend erfolgt eine
Gegenuberstellung der Beleuchtungsmodelle und eine kurze Einfuhrung

zum Begriff Shading.

5.1 Einfiihrung in die Beleuchtung

Bilder, durch die wir unsere Umgebung wahrnehmen, resultieren
letztendlich aus Licht, dass von einer Lichtquelle emittiert wird, an
Oberflachen der Umgebung reflektiert und schlieBlich auf unsere Netzhaut
auftritt. Um also ein moglichst realistisches Abbild der Wirklichkeit zu
erstellen, ist es notig, eine Abbildung der Physik des Lichtes zu simulieren.
Durch die Einbeziehung des Lichtes (und der daraus resultierenden
Schatten) ist es erst mdglich, trotz der zweidimensionalen Darstellung eine
Vorstellung davon zu erlangen, wie der geometrische Aufbau einer Szene
in der Realitdt ware. Da es sich bei unserem Aulenbereich um eine
kinstliche Welt handelt, braucht man Gesetze, die fur diese Welt gelten
ebenso wie die physikalischen Gesetze in der Wirklichkeit [ECG96]. Diese
.kunstlichen® Naturgesetze werden auch als Modell bezeichnet und
versuchen, der Realitat moglichst nahe zu kommen. Je nach
verwendetem Modell kdénnen so mehr oder weniger realistische

Ergebnisse erzielt werden. Auch fur Licht gibt es in der Computergrafik ein
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Modell: das sogenannte Beleuchtungsmodell. Hierbei unterscheidet man

zwischen lokalen und globalen Beleuchtungsmodellen.

5.2 Anforderungen an die Beleuchtung

Fir eine realistische Beleuchtung der Szene ergeben sich eine Reihe von
Anforderungen, die erflllt werden mussen. Die Wahl der Lichtquelle ist
abhangig davon, in wie weit sie die Eigenschaften der Sonne simuliert. Bei
direkter Sonneneinstrahlung werfen Objekte in der Natur sehr scharfe
Schatten. Dieses Kriterium gilt es, bei der Wahl der Schatten zu beachten.
Trifft Licht auf die Oberflache eines Materials, verhalt es sich je nach Art
des Materials unterschiedlich. Materialien wie Wasser werfen starke
Glanzlichter, Baumrinde dagegen absorbiert das Licht stark. Neben der
realistischen Simulation des Lichtes auf der Oberflache eines Materials ist
die Nachempfindung der Licht-Wechselwirkungen der Objekte der Szene

zu berucksichtigen.

5.3 Lichtquellen

Das Beleuchtungsdesign in einer dreidimensionalen Szene ist
vergleichbar mit einer realen Beleuchtung. Regeln und Funktionsweisen
der Lichtquelle unterscheiden sich jedoch maligeblich von der Realitat.
Die Lichtquellen der 3D Computergrafik (und in Maya) sind angelehnt an
die in unserer natlrlichen Umgebung vorkommenden Lichtquellen. Es
kénnen Umgebungslichter, Punktlichter oder Spotlichter definiert werden,
um Szenen mdoglichst realistisch auszuleuchten. Lichtquellen in der
Computergrafik bieten daruber hinaus aber noch weitere ,unrealistische®
Eigenschaften, die in der realen Welt nicht bzw. nur mit technischem
Aufwand erzielt werden koénnen. Es ist zum Beispiel moglich, Lichtquellen
zu definieren, die unendlich weit mit gleicher Intensitat strahlen, die keine
Schatten werfen, die durch bestimmte Objekte hindurchleuchten oder

negative Lichter, die beleuchtete Teile abdunkeln.
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5.3.1 Vergleich der Lichtquellen

Dieses Kapitel soll die von Maya bereitgestellten Lichtquellen kurz
vorstellen. Jede dieser Lichtquellen eignet sich fur bestimmte Szenarien.
Es soll nun untersucht werden, welche dieser Lichtquellen sich am besten

fur die Ausleuchtung eines AulRenbereichs eignet [ATLOG].

Die ambiente Beleuchtung (ambient light) ist die einzige indirekte
Lichtquelle, die Maya bietet. Ambiente Lichtquellen strahlen in alle
Richtungen gleich intensives Licht und sorgen fur eine allgemeine
Grundhelligkeit. Mit dieser Beleuchtung konnen flache, eintdnige
Farbschattierungen erzeugt werden. Eine Positionierung der Lichtquelle ist
somit nicht notig. Eine alleinige Verwendung von ambientem Licht macht
wenig Sinn, da Objekte vollkommen flach wirken (Abbildung 42). Ambiente
Beleuchtung wird in der Regel nur in Verbindung mit anderen Lichtquellen

zur Aufhellung einer Szene benutzt.

Abbildung 24  (links) Ambiente Lichtquelle, (rechts) Punktlichtquelle

Die Punktlichtquelle reprasentiert eine Lichtquelle an einer festen Position.
Das Licht wird dabei in alle Richtungen geworfen (omnidirektionales Licht).
Punktlichtquellen bieten sich immer dann an, wenn das Licht eine hohe
Intensitat in einem kleinen Gebiet hat, oder wenn es sich bei der
Lichtquelle um eine physikalische Reprasentation einer Kugel handelt.

Man verwendet Punktlichtquellen zum Beispiel, um das Licht einer
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Leuchtdiode oder einer Nachttischlampe 2zu simulieren. Fur die

Ausleuchtung des AulRenbereichs bietet sie sich jedoch nicht an.

Die Spotlichtquelle ist dem Spot-Scheinwerfer nachempfunden, welcher
im Theater oder bei Filmproduktionen eingesetzt wird. Sie emittiert das
Licht nur in einem begrenzten Kegel mit abnehmender Intensitat. Aufgrund
der Tatsache, dass die Lichtstrahlen bei der Spotlichtquelle niemals
parallel verlaufen konnen, eignet sie sich nicht zur Ausleuchtung eines
Auldenbereichs. Vielmehr konnen der Lichtwurf einer Taschenlampe oder

der eines Lampenschirmes mit ihr simuliert werden.

Abbildung 25  (links) Spotlichtquelle. (rechts) Flachenlichtquelle

Die Flachenlichtquelle basiert auf einer definierbaren Flache, die Licht in
eine Richtung emittiert. Die GroRe dieser Flache beeinflusst die Intensitat
des Lichtes. Flachenlichtquellen eignen sich am besten fur die
Ausleuchtung von Szenen bei denen das Licht aus einer flachen oder
engen Quelle stromt. Man nutzt Flachenlichtquellen, um zum Beispiel
Raume auszuleuchten, in die das Licht durch das Fenster oder Turspalten
gelangt. Fur die komplette Ausleuchtung eines Aullenbereiches ist diese

Lichtquelle jedoch ungeeignet.
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Die Richtungslichtquelle besteht aus einer ,Lichtrichtung“ ohne eine feste
Position zu haben. Sie simuliert parallele Lichtstrahlen, die in eine
bestimmte Richtung geworfen werden. Eine Richtungslichtquelle bietet
sich dann an, wenn sich die Lichtquelle in einer groen Distanz zum

Objekt befindet, wie es zum Beispiel bei Sonne und Mond der Fall ist.

Abbildung 26  Richtungslichtquelle

5.3.2 Schatten

Schatten sind ein unvermeidlicher Teil einer physikalischen Welt. Die
Verwendung von qualitativ hochwertigen Schatten stellen eine absolute
Notwendigkeit flr professionelle Renderings dar. Nach Wahl der
Lichtquelle, welche je nach Typ unterschiedliche Schatten wirft, muss man
sich fur eine Art der Schattenerzeugung entscheiden. Maya bietet zu
diesem Zweck zwei verschiedene Arten an: ,Depth Map Shadows® (DMS)
und ,Raytraced Shadows* (RTS).

5.3.3 Vergleich der Schattenarten

Die beiden angesprochenen Schattenarten werden nun anhand einer

kleinen Versuchsreihe in unterschiedlichen Szenarien gegenubergestellt.
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Ziel dieser Versuchsreihe ist es herauszufinden, wie gut die Qualitat der

beiden Schattenarten ist und wie sich die Renderzeit dazu verhalt.

Aus einer festen Kameraposition werden anhand der unterschiedlich
gewahlten Schattenarten Renderings zum Vergleich erstellt. Als

Lichtquelle dient in den Beispielszenen eine Richtungslichtquelle.

Abbildung 27  Scharfer Schattenverlauf: (links) DMS - 2sec. (rechts) RTS - 47sec

Abbildung 28  Weicher Schattenverlauf: (links) DMS - 4sec. (rechts) RTS - 58sec

Abbildung 29  ,PaintEffects” Modell: (links) DMS - 12sec. (rechts) RTS - 14sec
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Abbildung 30  ,Transparente“ Schatten: (links) DMS - 20sec. (rechts) RTS - 18sec

5.3.4 Abgleich mit den Anforderungen

Der Vergleich der Lichtquellen hat gezeigt, dass sich jede Lichtquelle fir
bestimmte Situationen anbietet. In den Anforderungen wurde festgelegt,
dass die verwendete Lichtquelle die Eigenschaften der Sonne simulieren
muss. Die Richtungslichtquelle erfullt alle Anforderungen und wird daher

als Lichtquelle fir die Szene dienen.

Die Untersuchung der unterschiedlichen Schattenarten hat gezeigt, dass
,DMS" bei geringer Renderzeit gute Ergebnisse liefern. Bei weichen
Schatten sind sie den ,RTS“ auch qualitativ ebenbirtig. Die durch
Sonnenlicht erzeugten Schatten sind in der Realitat relativ scharf. ,DMS*
liefern, wie Abbildung 29 zeigt, nur sehr grobe, verwaschene Schatten.
,RTS* brauchen bei komplexen Lichtsituation eine deutlich hdhere
Renderingzeit, liefern jedoch auch einen sehr scharfen Schattenverlauf.
Fir die Darstellung der Schatten werden fir die Szene Raytraced

Shadows verwendet.
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5.4 Lokale Beleuchtungsmodelle

Lokale Beleuchtungsmodelle simulieren das Verhalten von Licht auf
Oberflachen. Dabei wird die Helligkeit eines von einem Punkt auf der
Oberflache in eine bestimmte Richtung reflektierenden Lichtstrahls
berechnet [ECG96, S 140]. Strahlungsaustausch und Schatten werden
dabei nicht berucksichtigt. Die gebrauchlichsten lokalen
Beleuchtungsmodelle von ,Lambert” und ,Phong“ sollen im Folgenden

kurz beschrieben werden.

5.4.1 Lambert Beleuchtungsmodell

Dem Lambert'schen Beleuchtungsmodell liegt das Gesetz des Physikers
Johann Heinrich Lambert zugrunde. Es besagt, dass die Strahlungsstarke
von einfallendem Licht auf eine effektive Flache proportional zum Cosinus
des Einfallswinkels ist [LAM]. Mit diesem Modell kann ausschlieBlich die
Beleuchtung von diffus reflektierenden Oberflachen simuliert werden. Der
reflektierende Anteil des Lichtes in einem Oberflachenpunkt ist somit in

allen Richtungen gleich.

In Maya konnen mit dem Lambert'schen Beleuchtungsmodell sehr gut

Materialien wie Holz, Beton, Stein, Papier oder Stoff erzeugt werden.

Abbildung 31 Lambert Material in Maya, diffuse Oberflache
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5.4.2 Phong Beleuchtungsmodell

Mit den in Kapitel 5.4.1 angesprochenen diffusen Reflexionen kdénnen
matte Oberflachen dargestellt werden. In der Realitat zeigen aber selbst
matte Gegenstande bei direkter Beleuchtung oft einen gewissen Glanz.
Von einem bestimmten Winkel betrachtet, reflektieren sie einen Groliteil
des einfallenden Lichtes, so dass auf der Oberflache ein heller Punkt

erscheint, der annahernd die Farbe der Lichtquelle hat.

Beim Phong'schen Beleuchtungsmodell handelt es sich um ein
empirisches Modell, das auf keinerlei physikalischer Grundlage aufbaut
[PBM]. Das Modell besteht aus drei verschiedenen Komponenten: einer
ambienten, einer diffusen und einer spekularen. Die ambiente®
(umgebende) Komponente besagt, dass jedes Objekt gleichmaRig mit
ambienten Licht beleuchtet wird. Die diffuse Komponente entspricht dem
Lambert'schen Gesetz. Die spekulare Komponente betrachtet das Objekt
als spiegelnde Oberflache, an der Glanzpunkte entstehen, wenn sich der

Betrachter nahe der Reflexionsrichtung befindet.

In Maya konnen mit dem Phong'schen Beleuchtungsmodell sehr gut

Materialien wie Metall, Glas, Fliesen oder Plastik erzeugt werden.

Abbildung 32  Phong Material in Maya, Glanzlichter

2 Bei ambientem Licht kommt das Licht nicht von einer definierten Quelle, sondern
vielmehr aus allen Richtungen. [ATLO6]
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5.5 Globale Beleuchtungsmodelle

Im vorangegangen Kapitel wurden die zwei gangigsten lokalen
Beleuchtungsmodelle erklart, um die Lichtverhaltnisse an einem
bestimmten Punkt der Szene beschreiben zu kdnnen. ,Fir die Erzeugung
fotorealistischer Bilder ist aber auch die Modellierung der globalen
Beleuchtung, also der Licht-Wechselwirkungen aller Objekte der Szene
miteinander von Bedeutung [ECG, S. 163]“. Ohne sie konnten zum
Beispiel die Spiegelungen der Umgebung auf einer Wasseroberflache

nicht dargestellt werden.

Zu Beginn des Kapitels werden die Anforderungen an das globale
Beleuchtungsmodell festgelegt. Danach werden verschiedene Ansatze in
der Theorie erklart und anschlielRend anhand von Beispielszene in Maya
auf Eignung fur die Szene untersucht. AbschlieRend werden die
vorgestellten Ansatze miteinander verglichen und ihre Vor- und Nachteile

aufgefuhrt.

5.5.1 Anforderungen an die globale Beleuchtung

Fir die Beleuchtung der Szene spielt die Wahl des globalen
Beleuchtungsmodells eine entscheidende Rolle. Das Modell muss dabei in
der Lage sein, sowohl spiegelnde, als auch diffuse Oberflachenreflexionen
zu berechnen. Die Renderingzeit fur die Berechnung soll nicht zu hoch
ausfallen. AuRerdem soll die globale Beleuchtung in Maya mdglichst leicht

zu konfigurieren sein.

5.5.2 Raytracing

,D0er Ansatz des Raytracings geht auf Whitted und Appel zurick [APP68,
WHI80]. Mit Hilfe von Raytracing lassen sich spiegelnde Reflexionen
perfekt wiedergeben [ECG, S 163]“. Raytracing beschaftigt sich mit der
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Frage, woher Lichtstrahlen kommen. Berucksichtigt wird dabei nicht nur
das eintreffende Licht von Lichtquellen, sondern auch die indirekt
einfallenden Lichtanteile. Der Vorgang des Raytracings lauft dabei im
Vergleich zur Natur rickwarts ab. Das Nachverfolgen (,trace®) der
Lichtstrahlen (,ray®) beginnt dabei bei der Kamera. Diese Methode wird
daher auch als ,Backwards Raytracing® oder rekursives Raytracing
bezeichnet [ECG, S 179]. Mit Hilfe von Raytracing kdnnen Spiegelungen
(,ray-traced reflections®), Lichtbrechungen (,ray-traced refractions®) und

Schatten (,ray-traced shadows*, Vgl. Kapitel 5.2.2) berechnet werden.

Abbildung 33  (links) Lichtbrechungsindex von '1.0'. (rechts) Lichtbrechungsindex von '1.6'

Abbildung 34  (links) Anzahl Spiegelungen: '0'. (rechts) Anzahl Spiegelungen: '2'

Das Prinzip des Raytracings soll an dieser Stelle kurz erlautert werden. Zu
Beginn des Raytracing Prozesses wird das Blickfeld der Kamera in ein
Feld von zu berechnenden Bildpunkten umgewandelt. Raytracing verfolgt

nun fur jedes zu rasternde Pixel den Lichtstrahl und ermittelt den ersten
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Schnittpunkt mit dem Objekt (Primarstrahl). Von diesem Punkt aus werden
weitere Strahlen ausgesendet, die nach einfallenden Lichtstrahlen suchen.
Jetzt wird gepruft, ob das Objekt Uber reflektierende oder lichtbrechende
Eigenschaften verfugt. Diese sogenannten Sekundarstrahlen werden je
nach Materialeigenschaft nach dem Reflexionsgesetz oder dem
Brechungsgesetz berechnet. Die Sekundarstrahlen treffen gegebenenfalls
auf andere Objektpunkte, an denen dann gleich verfahren wird. Der
Abbruch der Rekursion erfolgt dabei entweder, wenn ein Strahl ohne
Schnitt mit einem Objekt aus der darzustellenden Szene lauft, oder wenn
eine vorgegebene maximale Rekursionstiefe erreicht ist [ECG96, S 171].
Die Renderzeit fur Raytracing ist abhangig von der Rekursionstiefe, der

Bildaufldsung und der Anti-Aliasing Einstellung.

lichtundurchlassiges Objekt

semitransparentes Objekt

— Primarstrahl n
Sekundéarstrahlen

Terziarstrahlen
------------- Schattenfihler

Abbildung 35  Prinzip des rekursiven Raytracings [DMA]

In Maya wird Raytracing in den Rendereinstellungen Uber ,Window >

Rendering Editors > Render Settings* eingestellt.
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5.5.3 Photon Mapping

Spiegelnde Reflexionen kénnen mit Raytracing perfekt wiedergegeben
werden. Diffuse Beleuchtung oder die Wiedergabe von indirekt
spiegelnder Beleuchtung koénnen dagegen nicht mit dieser Methode
realisiert werden. Um diese Probleme zu losen, wurden Erweiterungen
des Raytracings entwickelt. Eine davon ist das sogenannte Photon

Mapping welches auch fur Mental Ray verfugbar ist.

Das Photon Mapping besteht aus zwei Phasen. In der ersten Phase,
welche vor dem eigentlichen Rendervorgang ablauft, werden Photonen?
von der Lichtquelle in die Szene geschossen. Trifft ein Photon eine
Oberflache, werden sowohl Energie als auch seine Einfallsrichtung in die
sogenannte Photon Map eingetragen. Danach wird das Photon zufallig
reflektiert, oder es wird absorbiert. Nach Abschluss dieser Phase gibt die
Photon Map eine Approximation der Lichtverhaltnisse der gesamten
Szene [ECG96, S 177-178].

In der zweiten Phase wird die direkte Beleuchtung berechnet. Der
Unterschied zum regularem Raytracing ist jedoch, dass die indirekte
Beleuchtung durch andere Objekte bertcksichtigt wird und in der Photon

Map abgespeichert wird. Danach erfolgt die Berechnung der Szene.

Abbildung 36  (links) klassisches ,Raytracing®. (rechts) ,Photon Mapping®

21 energiebehaftete Partikel [ECG, S 177]"
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Um in Maya die globale Beleuchtung uber Photon Mapping berechnen zu
lassen, mussen zwei Dinge eingestellt werden. In den Einstellungen der
Lichtquelle muss Uber ,mental ray > caustics and global illumination > emit
photons® die Anzahl an Photonen eingestellt werden, die in die Szene
geschossen werden. Zusatzlich muss in den Rendereinstellungen ,Global

lllumination® und ,Photon Tracing® aktiviert sein.

5.5.4 Image Based Lighting

In den vorangegangenen Kapiteln wurden die zwei globalen
Beleuchtungsmodelle des Raytracings und des Photon Mappings
vorgestellt. Beide Modelle berechnen die Interaktion des Lichtes mit
Objekten ausgehend von einer oder mehreren Lichtquellen.
Fotorealistische Ergebnisse lassen sich mit den beiden Verfahren nur
erzielen, wenn man viel Zeit mit den Anpassungen der Lichtquellen

vornimmt.

Image Based Lighting (IBL) geht einen anderen Weg um globale
Beleuchtung zu erreichen: Es ersetzt die traditionellen Lichtquellen durch
leuchtende Objekte, um anhand dessen die tatsachliche Lichtintensitat zu

berechnen.

.IBL® wurde 1998 von Paul Debevec und Greg Malik auf der ,ACM-
SIGGRAPH?* Konferenz vorgestellt [RNL98]. Diese Methode globale
Beleuchtung zu erreichen, verwendet HDRI, um den gesamten Farb- und
Helligkeitsumfang einer Szene abzubilden. HDRI steht fir ,High Dynamic
Range Imaging“, Ubersetzt also Bildverarbeitung mit hohem
Dynamikumfang. Mit Dynamik ist hier nicht die Farbdynamik gemeint,
sondern die Kontrastdynamik [HDRO8]. Das HDR Bild kann in einem

22 Association for Computing Machinery's Special Interest Group on Graphics and
Interactive Techniques®
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HDRI-fahigen 3D Programm (wie z.B. Maya) dann als Lichtquelle

verwendet werden.

Der Prozess des ,IBL* beginnt mit der Auswahl eines HDR Bildes,
welches die Beleuchtungssituation der Szene wiederspiegeln soll. Wenn
nicht vorhanden, kann das HDR Bild Uber das Zusammenfigen einer
Belichtungsreihe (bestehend aus mehreren ,Low Dynamic Range“ Bildern)
mittels Software wie ,HDR Shop?*“[HDS] erstellt werden. Uber den Ablauf
der Erstellung eines HDR Bildes wird an dieser Stelle nicht weiter

eingegangen. Es sei hier auf die Literatur verwiesen [HDRO08].

Abbildung 37  Belichtungsreihe aus mehreren ,LDR Bildern“ [HDRO08]

Nachdem das HDR Bild erstellt ist, wird es in die entsprechende 3D
Software importiert. In Maya wird dann in den Rendereinstellungen tUber
»,Rendering > Rendering Settings > Mental Ray > Image based Lightning >
Create” ein ,IBL" Knoten fur die Szene erstellt. Dieser wird in der Szene
als Kugel dargestellt. Der ,IBL* Knoten wird nun selektiert und bekommt

Uber ,Image File“ das HDR Bild zugewiesen.

Fir die Beispielszene wurde ein ,HDR-Bild“ eines Sonnenuntergangs
verwendet. Abbildung 38 zeigt das fertige Rendering. Man beachte hierbei
den roten Schimmer, den das Licht an die Blattern wirft und die dezente

Farbung der Grasflache.

2 Freie Software zum Erstellen von HDR Bildern
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Abbildung 38  Baumszene aus Kapitel 4.4.1 mit Image Based Lighting
5.5.5 Mental Ray Physical Sun and Sky

Mental Ray Physical Sun and Sky (,PSAS®) ist eine speziell fir den Mental
Ray Renderer in Maya integrierte Losung zur Simulation von physikalisch
korrekt dargestellten Tageslicht-Situationen. Der Einsatz von ,PSAS®

bietet sich vor allem fur die Beleuchtung von Auf3enbereichen an.

Um ,PSAS" in Maya zu nutzen, muss zu Beginn der ,Mental Ray"
Renderer aktiviert werden. Uber ,Window > Rendering Editors > Render
Settings > Mental Ray” wird ,Mental Ray“ als Renderer festgelegt. In den
,Mental Ray“ Einstellungen werden danach uber ,Mental Ray >
Environment > Physical Sun and Sky > Create“ die erforderlichen Knoten
erzeugt. Maya erzeugt eine Richtungslichtquelle im Ursprung der Szene,
eine blaue Umgebung und eine virtuelle Sonne. Die Postion der Sonne ist
dabei an den Rotationswinkel der Umgebungslichtquelle gebunden. Je
nach Rotationswinkel werden somit die verschiedenen Lichtsituationen zu

unterschiedlichen Tageszeiten dargestellt (Abbildung 39).

PSAS” bietet dem Benutzer viele Maoglichkeiten zur Anpassung der
Lichtverhaltnisse und der Umgebung an. Die Umgebung, die nach

Erstellung aus einer himmelblau-gefarbten Kuppel besteht, kann mit einer
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Hintergrund-Textur versehen werden. Uber das ,Haze“ Attribut kann der

Szene ,Nebel in verschiedener Intensitat zugefiigt werden.

Abbildung 39  Physical Sun and Sky Szene bei unterschiedlicher ,Tageszeit*

Um eine Szene mit ,PSAS* zu rendern, missen zwei Dinge beachtet
werden. Zum Einen muss Final Gathering (Vgl. Kapitel 7.4) in den Mental
Ray Einstellungen aktiviert sein. Final Gathering ist ahnlich zum Photon
Mapping eine Methode zur Berechnung der globalen Beleuchtung. Es
eignet sich vor allem fir die Berechnung von diffusen Oberflachen. Der
zweite Punkt, den man beachten muss, ist die vor dem Rendervorgang
vorzunehmende Gamma-Korrektur. Mental Ray verwendet fur alle
Texturen einen Gammawert von '2.2'. Um dieses Problem zu l6sen,
erstellt man entweder einen ,GammaCorrect* Knoten und verknupft ihn
mit der Textur, oder man andert die Gamma-Einstellungen des

entsprechenden ,PSAS* auf einen niedrigeren Wert.

Abbildung 40 zeigt die bekannte Beispielszene unter Verwendung von
,PSAS*. Man beachte hierbei den realistischen Schattenwurf abhangig

von der ,Tageszeit".
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Abbildung 40  Physical Sun and Sky Baumszene bei unterschiedlicher ,Tageszeit"
5.5.6 Abgleich der Anforderungen

Die letzten Kapitel haben gezeigt, dass die unterschiedlichen Ansatze zur
globalen Beleuchtung alle gute Ergebnisse liefern. Bis auf das ,reine®
Raytracing sind alle vorgestellten Verfahren in der Lage spiegelnde als
auch diffuse Oberflachen zu berechnen. Photon Mapping ist das einzige
verwendete Verfahren, mit dem Kaustiken berechnet werden konnen. Die
Anpassung des Photon Mappings in Maya ist jedoch ein komplizierter
Prozess, der eine grof3e Anzahl an Tests mit sich bringt. Image Based
Lighting ist das benutzerfreundlichste Verfahren, wenn es darum geht,
globale Beleuchtung in Maya zu integrieren. Aufgrund der komplizierten
Anfertigung der HDR Bilder und der Tatsache, dass man flr die erstellte
Szene ein passendes HDR Motiv bendtigt, ist es nur bedingt einsetzbar.
Physical Sun And Sky in Verbindung mit Final Gathering bietet sich von
allen vorgestellten Verfahren am Besten fur die Berechnung der globalen
Beleuchtung an. Aufgrund der dynamischen Anpassung der
Tageslichtsituationen durch die Richtungslichtquelle ergibt sich die
Moglichkeit, mit wenigen Handgriffen die modellierte Szene zu mehreren
Tageszeiten zu rendern. Die Anpassung der unterschiedlichen ,Tageszeit"

soll auch im finalen Rendering berlcksichtigt werden (Vgl. Kapitel 8.1).
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6 Texturierung und Shading

Nachdem die Beleuchtung der Szene beschrieben wurde, befasst sich
dieses Kapitel damit, die erstellten Objekten mit natarlichen
Oberflacheneigenschaften zu versehen. Zu Beginn des Kapitels werden
die Begriffe Texturierung und Shading etwas naher betrachtet. Danach
erfolgt die Festlegung der Anforderungen. Texturierung und Shading sind
der dritte und letzte Schritt in Richtung Fotorealismus. Nachdem die
Grundlagen sowie die bekanntesten Mapping Techniken besprochen sind,
wird das in Kapitel 4.2 modellierte Gelande texturiert. Komplexe
Materialien wie Wasser und Wolken werden anhand verschiedener
Techniken erstellt und aufgezeigt, welches Verfahren sich am Besten

eignet.

6.1 Grundlagen der Texturierung

Die Realitat bietet eine Vielzahl von geometrischen Feinstrukturen. Holz
weist eine Maserung auf, Marmor hat ein bestimmtes Muster und Tapeten
besitzen eine Raufaser. Um diese detaillierten Oberflachen polygonal zu
modellieren, bedarf es einer Vielzahl von kleinen Polygonen. Im Bezug auf
Renderingzeit, Modellierungsaufwand und Speicherplatzbedarf ist diese
Art der Oberflachendarstellung nicht akzeptabel. Es bedarf also einer
pragmatischen Losung, diese Details darzustellen. James F. Blinn?* hat
dieses Problem in einem Satz passend beschrieben: ,All it takes is for the

rendered image to look right.”.

Der Vorgang der Texturierung geht davon aus, dass die Oberflache, zum
Beispiel einer Wand, als ein einziges Polygon modelliert werden kann.
Danach wird ein Bild auf die Oberflache aufgebracht. Diesen Vorgang des

.lapezierens® bezeichnet man in der Computergrafik als Texturierung.

2 Naturwissenschaftler, der durch seine Arbeiten in der Computergrafik bekannt wurde.
Unter anderem ist er der Erfinder des ,Blinn-Phong* Beleuchtungsmodells und des
,Bump-Mappings*“.[JFB]"
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Hier unterscheidet man drei unterschiedliche Aspekte. Das Hinzufligen
eines Musters zu einer glatten Flache bezeichnet man Texture-Mapping.
Durch Displacement-Mapping und Bump-Mapping wird der Eindruck von
Rauheit bei einer glatten Oberflache erzeugt. Die Simulation der
Umgebung auf der Oberflache wird als Environment-Mapping oder

Reflection-Mapping bezeichnet.

6.2 Mapping Verfahren

Das Streben nach Fotorealismus bringt die Notwendigkeit der
Berucksichtigung von Details der Szene mit sich. ,Um den daraus
resultierenden Aufwand in Grenzen zu halten, wurden ,Mapping®
Verfahren eingefuhrt, die die explizite Modellierung solcher Details
vermeiden‘[ECG96, S 195]. Dieses Kapitel soll anhand kleiner
Beispielszenen den Einsatz von Texture-Mapping, Displacement-

Mapping, Bump-Mapping und Environment-Mapping aufzeigen.

6.2.1 Texture-Mapping

Beim Texture-Mapping werden Flachen dreidimensionaler
Oberflachenmodelle mit zweidimensionalen Bildern, sogenannten

Texturen®, und Oberflacheneigenschaften ausgestattet.

Das Mapping beschreibt dabei, wie die Textur auf das 3D Objekt
aufgebracht wird (Abbildung 41). Man unterscheidet hier zwischen
Planarem-Mapping, Box-Mapping, Zylinder-Mapping und Kugel-Mapping.
,Die aufzutragende Textur wird dabei in einer Matrix (Texture-Map) aus
einzelnen Bildelementen (Texel?®®) gespeichert, die die Intensitats- bzw.

Farbinformationen enthalt. Diese rechteckige Textur wird dann mittels

% In der Computergrafik bezeichnet eine Textur ein Bild, welches fiir 3D Modelle als
Uberzug verwendet wird. Der Detailgrad wird dabei erhéht ohne die Geometrie zu
verandern.” [TEX]

% Abkirzung fur ,Texture Pixel“. Ein einzelner Pixel innerhalb der Texture Map [ECG96]
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einer inversen Abbildung auf die entsprechende Oberflache abgebildet"
[ECG96, S 196].

Abbildung 41  Zweidimensionales Texture-Mapping

In der Beispielszene werden nun einige primitive Objekte erstellt und Uber
Texture-Mapping Texturen angebracht. Als Textur dient ein einfacher
.,Ramp Shader”, der die Regenbogenfarben zeigt. Im linken Bild von
Abbildung 42 kann man erkennen, dass die Textur lediglich bei der Flache
richtig angeordnet ist (erkennbar an dem kompletten Spektrum der
Regenbogenfarben). Das liegt daran, dass Maya nicht automatisch das
richtige Mapping-Verfahren fir das primitive Objekt verwendet. Nach
Anwendung von Zylinder-Mapping, Kugel-Mapping und Box-Mapping auf
die Objekte, wird die Textur auf den Objekten richtig dargestellt.

Abbildung 42  Texture-Mapping: vor (links) und nach (rechts) Anwendung von Zylinder-,
Kugel-, und Box-Mapping
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6.2.2 Bump-Mapping

Zur Darstellung reliefartiger Texturen wurde als Variante des Texture
Mappings das sogenannte Bump-Mapping von James F. Blinn eingefuhrt
[JBL78]. Die Geometriekomplexitat des Objektes wird hierbei nicht erhoht.
Die Idee des Bump-Mappings besteht darin, durch Variation der

Oberflachennormale eine Oberflachenrauheit zu simulieren.

P

smooth sartace wrinkle fFunction

5,

wrinkled surface

Abbildung 43  Funktionsweise des Bump-Mappings [JBL78]

Die Bump-Map (oder Height-Map) besteht dabei aus einer Textur, die in
Graustufen vorliegt. Jeder Grauwert reprasentiert dabei eine bestimmte
Hohe [ECG96, S. 197]. In Maya steht schwarz (1) fur die tiefste Stelle und
weild (0) fur die hochste Stelle. Die folgende Abbildung 44 zeigt eine

Beispielszene mit und ohne dem Einsatz von Bump-Mapping.

Abbildung 44  Beispielszene ohne (links) und mit (rechts) Bump-Mapping
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6.2.3 Displacement-Mapping

Displacement-Mapping ist ein weiteres Verfahren, Oberflachen um
detaillierte Strukturen zu erganzen. Das bereits vorgestellte Bump-
Mapping ermoglicht nur die Darstellung von Strukturen mit niedriger
Frequenz, wahrend es zur Simulation von grof3en Verschiebungen und
Selbstverdeckung ungeeignet ist. Im Gegensatz zum Bump-Mapping
Verfahren wird beim Displacement-Mapping nicht das Erscheinungsbild
der Oberflache verandert, sondern direkt die Geometrie des Objektes.
Aufgrund dieser zusatzlichen Geometrie ist Displacement-Mapping die
rechenintensivste Mapping-Technik. Es entstehen jedoch auch groRe
Vorteile: Durch die veranderte Geometrie bleibt die Struktur auch aus
einem flachen Betrachtungswinkel erhalten. Dies wirkt sich vor allem

positiv auf den realistischen Schattenwurf aus.

Beim Displacement-Mapping werden die Informationen Uber die Struktur
der darzustellenden Oberflache einem Height Field entnommen. Mit dem
aus dem Height Field gewonnenen Hohenwert wird nun jeder Vertex der
Originaloberflache entlang seiner Normalen um diesen Hohenwert
verschoben [DPM]. Voraussetzung flr dieses Verfahren ist die detaillierte
Unterteilung der zugrunde liegenden Oberflache an den entsprechenden
Stellen (Abbildung 45).

Abbildung 45  Beispielszene ohne (links) und mit (rechts) Displacement-Mapping
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6.2.4 Environment-Mapping

Das letzte hier vorgestellte Mapping Verfahren, ist das Environment- oder
Reflection-Mapping. Es wird zur einfachen Realisierung von Spiegelungen
auf einem Objekt eingesetzt, ohne dabei den Aufwand von Raytracing zu
nutzen (Vgl. Kapitel 5.5.2). Damit eignet es sich vor allem fur
Echtzeitberechnungen. ,Beim Environment-Mapping wird die Umgebung
eines Objekts, die sich in dem Objekt spiegeln soll, zunachst auf eine das
Objekt umgebende Sphare (abhangig vom Verfahren) projiziert, die dann
als zweidimensionale Texture-Map betrachtet wird [ECG96, S. 199]“.
Vereinfacht ausgedrickt wird dann der Sichtstrahl des Beobachters per
Reflexionsgesetz Uber die Oberflachennormale gespiegelt. Der dabei
errechnete Reflexionsvektor bestimmt den Index auf der Umgebungstextur

(Environment Map).

Fir die Beispielszene (Abbildung 46) wurde eine Teekanne erstellt und
eine ,Environmental Sphere“ mit einer Textur der Fachhochschule Koln
verknupft. Die ,Environmental Sphere* wird nun Uber den Hypershade
Editor mit dem Phong-Material der Teekanne als ,reflected Color*
verknlpft. Maya verwendet nun ,Environmental Sphere Mapping“ um die
Spiegelungen darzustellen. Neben ,Sphere Mapping® unterstitzt Maya

auch ,,Cube Mapping“.

Abbildung 46  Beispielszene ohne (links) und mit (rechts) Environmental-Mapping
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6.3 Shading

Die Kapitel Uber lokale und globale Beleuchtungsmodelle haben die
verschiedenen Moglichkeiten aufgezeigt, wie einzelne Punkte eines
Objektes beleuchtet werden und wie die Licht-Wechselwirkung aller
Objekte der Szene ablauft. Wie allerdings Reflexionen und Transparenz
dargestellt werden konnen, wird in diesem Kapitel geklart. Das Kapitel
beschreibt den Begriff des Shadings und erklart kurz die drei wichtigsten
Shading Modelle. AbschlieRend wird am Beispiel der Erstellung eines

Holz-Shaders der Arbeitsprozess in Maya aufgezeigt.

6.3.1 Grundlagen des Shadings

Beleuchtung und Shading (Schattierung) sind eng miteinander verbunden.
Von David Kirk, Wissenschaftler bei der Firma nVidia, stammt der Satz:
.Beleuchtung ist der Helligkeitswert, wdhrend es beim Shading um
Reflektionen und/oder Lichtdurchléassigkeit geht‘ [NVA]. Wahrend sich die
Beleuchtung damit beschaftigt, woher das Licht kommt und mit welcher
Intensitat es auf die Oberflache trifft, beschreibt das Shading, wie das
Material der Oberflache auf das Licht reagiert. Das Shading umfasst
sowohl die Auswahl eines geeigneten lokalen Beleuchtungsmodells, als
auch die Entscheidung, in welchen Punkten billigere
Interpolationsverfahren eingesetzt werden sollen [ECG, S. 154]. Die drei
gangigsten Verfahren sind das Flat Shading, das Gouraud Shading und
das Phong Shading (Abbildung 47).

Das Flat Shading beschreibt den einfachsten Ansatz. Das lokale
Beleuchtungsmodell wird in nur einem Punkt des Polygons angewandt.
Der daraus ermittelte Wert wird dann flir das komplette Polygon

ubernommen [ECG, S. 155]. Durch diese starke Vereinfachung kénnen an
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Kanten starke Intensitatssprunge entstehen. Diese konnen durch den

auftretenden ,Mach-Band-Effekt?”“ noch verstarkt werden.

Das Gouraud Shading interpoliert die Intensitats- bzw. Farbinformationen
anhand der Oberflachennormalen der Vertices. Die Bildqualitat beim
Gouraud Shading ist héher als beim Flat Shading, jedoch tritt ein Verlust
von besonders hohen oder niedrigen Intensitaten auf [ECG, S. 156].
Gouraud Shading ist auch heute noch in den meisten Hardwarelosungen
implementiert und wird damit meistens bei Echtzeitanwendungen

verwendet.

Im Gegensatz zum Gouraud Shading werden beim Phong Shading nicht
die Intensitaten sondern die Normalenvektoren interpoliert. Mit Hilfe des
lokalen Beleuchtungsmodells wird der Farbwert des Pixels fur jeden
Farbkanal bestimmt. Das Phong Shading liefert eine zum Teil erheblich
bessere Qualitat als das Gouraud Shading, was vor allem bei spiegelnden
Reflexionen sichtbar der Fall ist [ECG, S. 158]. Aufgrund des deutlich
héheren Aufwandes gegenuber dem Gouraud Shading wird das Phong

Shading meist nur bei softwaremafigen Implementierungen verwendet.

Abbildung 47  Von links nach rechts: Flat Shading, Gouraud Shading, Phong Shading

" Eine dunkle Flache erscheint entlang einer Kante, an der sie auf eine hellere trifft, als
noch dunkler. [MBE]
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6.3.2 Erstellung eines Holz-Shaders in Maya

Es soll nun am Beispiel eines Holz-Shaders die Arbeitsweise bei der
Shader-Erstellung in Maya gezeigt werden. Dieses Kapitel fuhrt die
grundlegenden Arbeitsschritte bei der Shader-Erstellung in Maya ein und

soll den Leser auf die folgenden Kapitel vorbereiten.

Um realistisches Holz darzustellen, verwendet man als Grundlage am
Besten ein Foto von Holz. Wenn keins vorhanden ist, kann man die
lllusion auch dadurch erzeugen, dass man ein weniger passendes Bild,
wie z. B. ein Rost-Bild durch geschickte Teilung der UV-Koordinaten

(Texel Koordinaten) verwendet.

In Maya wird jetzt im Hypershade Editor, der Uber ,Window > Rendering
Editor > Hypershade* aufgerufen wird, ein Blinn Material erstellt. Blinn ist
ein lokales Beleuchtungsmodell, welches als Grundlage das Phong
Beleuchtungsmodell verwendet. Die verwendete Textur wird jetzt mit dem
Farb- und Bump-Attribut des Blinn Materials verbunden. Dadurch
bekommt das Material die Textur als Oberflache zugewiesen. Die
Verbindung mit dem Bump-Attribut sorgt flir einen hdheren
Oberflachendetailgrad und sorgt so fir etwas ,Tiefe“. Rendert man an

dieser Stelle, bekommt man das in Abbildung 48 dargestellte Ergebnis.

Burmp Mapping |wo-:-d_te:<ture =]

Diffuse |0.800 I—

Tranglucence |0.000 1]
Tranzucence Depth 0500 — |
Tranghucence Focus (0600 ]

j Specular Shading

Eccentricity |0.300 |

Specular Roll OF [0.700 —

Specular Calor - |
Reflectivity |0.500 —J

Reflected Color - l

Abbildung 48  (links) Rendering Holz, (rechts) verwendete Einstellungen

" "
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Das Ergebnis sieht zwar auf den ersten Blick nicht schlecht aus, bei
genauerem Hinsehen fallt jedoch auf, dass das Glanzlicht fur Holz zu stark
ausgepragt ist. Um ein realistisches Ergebnis zu erlangen, sind noch ein
paar Einstellungen nétig. Neben der Anpassung des ,Specular Shadings*
werden noch einige Einstellungen der Textur vorgenommen, um eine

feinere Maserung zu erhalten (Abbildung 49).

Bump M apping |w00d_te:-cture =]
Diffuse |0.950 I

Translucence W '
Translucance Depth W il
Translucence Focus W —|
j Specular Shading
E coentricity W —
SpecularRol O [0220  —— fF——————

Specular Color [l

Reflectivity |0.500 —|
Reflected Color - il

n ="R="N="

=R =N =N ="

Abbildung 49  (links) Finales Rendering Holz, (rechts) verwendete Einstellungen
6.4 Texturierung des Gelandes

Nachdem die Grundlagen in Bezug auf Texturierung gelegt sind, wird nun
das modellierte Gelande aus Kapitel 4.2 realistisch texturiert. Zu beachten
gilt es hierbei, dass sich das Gelande aus unterschiedlichen
Vegetationsabschnitten zusammensetzen soll, die unterschiedlich
texturiert werden muissen. Neben dem abgesetzten Bereich, der spater
durch Wasser erganzt werden soll, muss der angrenzende Bereich eine
Grastextur bekommen. Der hintere Teil des Gelandes soll wenig

Vegetation bieten und felsig wirken.

6.4.1 Anforderungen an die Oberflache

Um realistische Ergebnisse zu erzielen, mussen zwei entscheidende
Dinge beachtet werden. Erstens muss ein geeignetes Beleuchtungsmodell

fur die Oberflache des Gelandes gewahlt werden. Daneben soll mit Hilfe
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der vorgestellten Mapping-Techniken ein hoherer Detailgrad der

Oberflache erreicht werden.

6.4.2 Umsetzung der Techniken in Maya

Um das Gelande in mehreren Abschnitten zu texturieren, bietet Maya das
,3D Paint Tool* an, welches es erlaubt, Bereiche der Oberflache direkt
.per Hand“ zu bemalen. In unserem Falle dient das ,3D Paint Tool“ jedoch
nur dem Zweck eine Maske zu erstellen, die fur den endgultigen Shader
verwendet wird. Zu Beginn wird dem Gelande als Material ein Lambert
zugewiesen. Lambert wird hier verwendet, da es sich um eine matte, nicht
reflektierende Oberflache handelt. Danach erfolgt Gber ,Rendering >
Texturing > 3D Paint Tool* die Auswahl des Werkzeugs. Dem Gelande
wird Uber , Tool Settings > File Texture > Asign / Edit Textures* eine Textur
zugewiesen. Diese Textur dient nachher als Maske. Nun wird der Bereich
»=angestrichen®, welcher im spateren Verlauf die Felsen darstellen soll.
Dieses Verfahren wird wiederholt, mit dem Unterschied, dass diesmal das

Gelande bemalt wird, welches die Grasflache zeigen soll (Abbildung 50).

Abbildung 50  (links) modelliertes Terrain, (rechts) mit 3D Paint Tool markierter Bereich

Ist dies geschehen, werden die erstellten Lambert Shader geléscht, da nur
die Texturen (Masken) gebraucht werden. Jetzt wird ein weiterer Lambert
Shader erstellt und dieser mit einer Layered Texture verbunden. Die

Layered Texture erlaubt es mehrere Texturen miteinander zu verbinden
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und diese uber verschiedene Funktionen miteinander zu vermischen. In
der Layered Texture werden jetzt drei verschiedene Farben erstellt.
Jeweils eine fur Gras, Felsen und Schlamm. Die Masken werden danach
mit dem ,Alpha Kanal“ der drei Farben verknupft und mit der Funktion
.blend“ (vermischen) versehen. Das bewirkt, dass sich die drei Bereiche

nun miteinander vermischen (Abbildung 51).

Abbildung 51  Texturiertes Gelande in der Rohfassung

Das Gelande wirkt zu diesem Zeitpunkt noch nicht realistisch. Um dies zu
andern, werden drei Shader fur Gras, Felsen und Schlamm erstellt. Da es
sich um matte, nicht reflektierende Oberflachen handelt wird wieder ein
Lambert Shader verwendet. Die einzelnen Shadern werden jetzt mit
Texturen fur Gras, Felsen und Schlamm verknupft. Danach wird die
verwendete Textur auch als Bump-Map genutzt. Abschlieliend werden die
Wiederholungen der Texturen erhdht, um einen grélieren Detailgrad zu
erlangen. Das Gelande ist nun fertig texturiert und kann mit den bereits
vorgestellten Techniken der Modellierung ,bepflanzt” werden. Das erstellte
Shader-Netzwerk sowie das Ergebnis zeigen Abbildungen 52 und 53.
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Abbildung 52  Shader-Netzwerk des Gelandes

Abbildung 53  Fertig texturiertes Gelande
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6.5 Reproduktion von Wasser

Der nachste Schritt besteht darin, das modellierte und texturierte Gelande
um eine Wasserflache zu erganzen. Zu Beginn des Kapitels wird auf die
physikalischen Eigenschaften von Wasser eingegangen und erklart,
worauf bei der Erstellung zu achten ist. Danach erfolgt ein kurzer Einblick
in das Modul Maya Fluids, mit welchem die Wasseroberflache erzeugt

wird. Zuletzt wird die Erstellung des Wasser Shaders erklart.

6.5.1 Eigenschaften von Wasser

Um fotorealistisches Wasser zu simulieren, muss man verstehen, wie
Wasser sich in der Natur verhalt. Es gibt viele unterschiedliche Sorten von
Wasser. Das Aussehen des Wassers hangt davon ab, wie grof3 und wie
tief das ,Wasserbehaltnis® ist (man vergleiche eine Pfutze mit einem See).
Daneben spielen Wetter, Umgebung, Verschmutzung und andere
Faktoren eine Rolle. Um realistisches Wasser nachzubilden, muss man es

also im Kontext der Szene sehen und dementsprechend anpassen.

Abbildung 54  Wasser in der Aggertalsperre [ATS]
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FUr unsere Beispielszene soll ein kleiner See erstellt werden. Als
Vergleich dient das Wasser aus Abbildung 54. Da es sich bei einem See
um ein stiles Gewasser handelt, treten hier keine groleren
Wellenbewegung auf. Lediglich der Wind ist dafur verantwortlich, dass
sich die Wasseroberflache leicht krduselt und vereinzelte Wellen auftreten.
Auffallig in Abbildung 54 sind vor allem die Reflexionen an der
Wasseroberflache: Wasser ist transparent und bei direktem Lichteinfall
stark reflektierend. Abhangig vom Betrachtungswinkel, kann man durch
das Wasser durchsehen oder es wirkt wie ein Spiegel. Diese
Eigenschaften gilt es nun bei der Reproduktion von Wasser zu

berucksichtigen.

6.5.2 Maya Fluids

Maya Fluids ist ein Modul, mit dem realistische Simulationen von flissigen
Stoffen moglich sind [AUT]. Durch die groRe Anzahl an
Einstellungsmaoglichkeiten lassen sich eine Vielzahl von Effekten erzielen,
die von 2D- und 3D -atmospharischen, -pyrotechnischen oder
-zahflissigen Stoffen ausgehen. So lassen sich zum Beispiel Flammen,
Explosionen, Wolken oder Rauch fotorealistisch generieren (Abbildung
55). Das Hauptanwendungsgebiet von Maya Fluids ist die physikalische

Simulation bestimmter Ablaufe (z.B. Simulationen im Windkanal).

Abbildung 55  Maya Fluid Effekte: (links) Flamme, (rechts) Explosion
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Aber auch fur die Erstellung von fotorealistischen Renderings kdnnen
Fluids verwendet werden. Fir unsere Szene ist die Erstellung eines
Ozeans mittels Fluids ein komfortabler Weg, eine realistische
Wasseroberflache zu erzeugen. Uber die vielen Einstellungsméglichkeiten
kann man Werte wie Wellengeschwindigkeit, Windgeschwindigkeit oder
Wellenschaum den Anforderungen der Szene bequem anpassen. Man
kann sich Fluids aber flUr weniger geeignet erscheinende Probleme zu
Nutze machen. Die Oberflache eines sturmischen Ozeans kann zum
Beispiel daflr genutzt werden, eine Gebirgslandschaft darzustellen
(Abbildung 56).

Abbildung 56  (links) Maya Fluid Gebirge, (rechts) stiirmischer Ozean

6.5.3 Umsetzung der Techniken in Maya

Nachdem die Grundlagen in Bezug auf Maya Fluids gelegt sind, wird in
diesem Kapitel die Wasseroberflache mit Fluids erstellt. Zwar ist es
moglich, die Wasseroberflache auch mit einer Displacement-Map zu
erstellen, jedoch bietet sich die Erstellung Uber Fluids an. Mit ihnen ist es
mdglich, viel individueller auf die Anforderungen der Szene zu reagieren.
Die Reproduktion von Wasser wird in zwei Schritten behandelt. Zuerst
wird Uber Fluids eine Oberflache erstellt. Im zweiten Schritt wird ein

Wasser-Shader erstellt, der dann mit der Oberflache verknupft wird.
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Die Erzeugung einer 2D Fluid Oberflache in Maya ist aufgrund der
vorhandenen Voreinstellungen fur Wasser ein unkomplizierter Vorgang.
Um eine 2D ,Fluid“ Oberflache zu erzeugen, wird Uber ,Dynamics > Fluid
Effects > Ocean > Create Ocean“ ein ,2D Fluid-Ozean® erzeugt. Jetzt
muissen nur noch die Einstellungen flir Wellengeschwindigkeit,
Wellengestalt und Windgeschwindigkeit dem Szenario eines ruhigen Sees
angepasst werden. Abschlielend wird die erstellte Oberflache in eine

Polygonflache konvertiert.

Nachdem die Oberflache erstellt ist, erfolgt der zweite Schritt, um
realistisches Wasser zu erzeugen. Der Ozean-Shader, der bisher mit der
erstellten Oberflache verknupft ist, erfullt nicht die Anforderung fur ein
fotorealistisches Rendering. Daher wird ein speziell fir Mental Ray
mitgelieferter Shader verwendet: ,mia_material®®‘. Die Anpassungen des

verwendeten Shaders werden im Folgenden nun detailliert erklart.

Abbildung 57  Mia_material-Wasser Voreinstellungen

Zu Beginn wird der Hyphershade Editor gedffnet und Uber ,Create >
Mental Ray materials > mia_material' ein mia_material-Shader erstellt.
Dieser wird selektiert und Uber "Presets > Water > Replace" die
Voreinstellungen fir Wasser geladen. Dadurch sind die wichtigsten Werte,

wie der Brechungsindex von Wasser, bereits richtig eingestellt. Nach

#Ein speziell fir ,Mental Ray“ mitgelieferter Shader, mit dem die meisten festen
Materialien (Metall, Glas, Holz, etc.) nachgebildet werden kénnen. [MIA]
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einem Rendering (Abbildung 57, links) erkennt man, dass die Reflexionen
zwar richtig dargestellt werden, man jedoch nicht durch das Wasser

hindurchsehen kann.

Das liegt daran, dass die Voreinstellungen des Shaders fur
Ozeanoberflachen ausgelegt sind. Der einfachste Weg, um durch das
Wasser zu sehen, besteht darin, die Transparenz des Shaders zu
erhéhen. Dies hat jedoch zur Folge, dass die Ubergdnge an der Kachel-
Textur sehr scharf dargestellt werden (Abbildung 57, rechts), was nicht
realistisch ist. Betrachtet man die Teekanne, so wirkt es, als ob diese Uber
das Wasser ,fliegen“ wirde. Es muss also ein anderer Weg gefunden
werden das Wasser transparent erscheinen zu lassen. Mia_material bietet
fur diese Problemstellung viele Einstellungsmdglichkeiten in Bezug auf
Brechkraft (refraction) und Reflexion (reflection). Hiermit ist es mdglich,
den angestrebten Effekt zu simulieren und so fotorealistisches Wasser
darzustellen (Abbildung 38).

Abbildung 58  Mia_material Wasser, mit angepassten Werten
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6.5.4 Abgleich mit den Anforderungen

Durch das Zusammenspiel von Fluid Oberflachen und einem
mia_material-Shader ist es moglich, fotorealistische Ergebnisse von
Wasser zu erzeugen. Die Schwierigkeit, die sich bei der Reproduktion von
Wasser ergibt, liegt in den komplizierten Anpassungen des Shaders.
Abhangig von der Art des Szenarios, muss in den Shader-Einstellungen
darauf reagiert und Anpassungen vorgenommen werden. Die von Maya
angebotene Voreinstellung von Wasser bietet jedoch eine gute Grundlage,

um zufriedenstellende Ergebnisse zu erzielen.

6.6 Reproduktion von Wolken

Das letzte Kapitel im Abschnitt Texturierung und Shading behandelt die
Reproduktion von Wolken. Es wird der Ansatz verfolgt, ,echte“ 3D Wolken
Uber Maya Fluids zu erzeugen. Zu Beginn wird jedoch auf die
Eigenschaften von Wolken eingegangen und damit die Anforderungen
festgelegt.

6.6.1 Eigenschaften von Wolken

Eine Wolke ist eine Ansammlung von Wassertropfchen, die in einigem
Abstand zur Erdoberflache in der Atmosphare schwebt. Wie bei
bodennahem Nebel oder Dunst, handelt es sich um die sichtbaren
Kondensationsprodukte des Wasserdampfs [BHAO02]. Da eine Wolke aus
Millionen von kleinsten Partikeln besteht, ist die Reproduktion in der
Computergrafik auerst schwierig und rechenintensiv. Aufgrund dieser
Problemstellung gibt es Ansatze, Wolken mit Hilfe von Uberlagerten
Texturen oder der Verwendung eines Shaders nachzubilden [SIG04].
Hierdurch entsteht jedoch ein entscheidender Nachteil. Wenn das
Sonnenlicht auf eine Wolke trifft, wird es in abgeschwachter Form auf der

Erdoberflache ankommen. Hierdurch entstehen komplexe
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Schattensituationen an der Erdoberflache, die mit den beiden Methoden
nur schwer nachgebildet werden kénnen (Abbildung 59). Neben dem
Schattenwurf ist die direkte Sonneneinstrahlung auf eine Wolke, eine
schwierig nachzubildende Situation. Hierbei entstehen komplexe

Reflexionen und Blendeffekte.

Abbildung 59  (links) Wolken [BMU], (rechts) Schattenwurf von Wolken [WFO]

6.6.2 Reproduktion in Maya

Es wird nun detailliert auf die Reproduktion von Wolken mit Hilfe von Maya
Fluids eingegangen. Zu Beginn wird Uber ,Dynamics > Fluid Effects >
Create 3D Container” ein Fluid Behalter erstellt. Dieser Behalter dient als
Umgebung fir die Fluid Partikel. Jetzt werden Auflésung und GréflRe des
Behalters erhdht. Nachdem diese Grundeinstellungen getatigt sind,
werden Farbe (ein Farblibergang von weiss nach schwarz) und

Transparenz der Wolken eingestellt.

Abbildung 60  Fluid Container ohne (links) und mit Modifizierung der Deckkraft (rechts)
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Uber ,Opacity > Opacity Input > Constant* wird nun die Deckkraft der
Wolken eingestellt. Im ,Fluid Container® erscheint jetzt ein einzige, grol3e
Wolke (Abbildung 60, links). Um aus dieser einen grol3en Wolke nun viele
kleine zu erzeugen, werden Uber , Textures > Texture Type > Perlin Noise*“
und die Einstellungen der Deckkraft (Opacity) die Struktur und GroRRe der
Wolken eingestellt. So ist es mdglich von der Gewitterwolke bis hin zur
Schafchenwolke jede Art von Wolke realistisch nachzubilden (Abbildung
60, rechts).

6.6.3 Abgleich mit den Anforderungen

Das vorangegangene Kapitel hat gezeigt, dass es mit Hilfe von Maya
moglich ist, fotorealistische Wolken zu erzeugen. Aufgrund der vielen
kleinen Fluid Partikel ist auch die Darstellung realistischer Schatten und
Blendeffekte ohne Weiteres mdglich. Dieses Hochstmall an Realismus
schlagt sich jedoch in einer sehr hohen Renderzeit nieder. Abbildung 61

zeigt nun eine Gegenuberstellung von echtem Foto und Reproduktion.

Abbildung 61 Vergleich zwischen echten (links) und nachgebildeten Wolke (rechts)
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7 Rendering

In diesem Kapitel wird die fertig modellierte Szene fur das Rendering
vorbereitet. Zuerst wird beschrieben, wie der Renderingprozess konkret
ablauft. Danach wird die fertige Szene ,aufgeraumt®, um Fehler zu
vermeiden, die zu verlangerten Renderingzeiten nfliihren kénnen. Dabei
wird auch das Rendern Uber die Kommandozeile erlautert. Abschlief3end
wird die Wahl des Renderers getroffen und wichtige Einstellungen kurz
erklart.

7.1 Der Renderingprozess

Der Begriff des renderns (engl. etwas machen, leisten) beschreibt in der
3D Computergrafik die Erzeugung eines zweidimensionales Bildes aus
einer dreidimensionalen Szene. Das zweidimensionale Bild kann dann auf
einem Ausgabegerat, z.B. auf einem Bildschirm ausgegeben werden. Die
eigentliche Funktionsweise des jeweiligen Renderers wird dabei Uber die
sogenannte Rendering-Pipeline beschrieben. Diese stellt eine Sequenz
von einzelnen Bearbeitungsschritten dar (Abbildung 62) [ECG, S. 193].

Rendering-Pipeline

Objekt- i  welt- { Kamera-  Clipping- Bild- i Gerate-
koordinaten E koordinaten E koordinaten g koordinaten g koordinaten g koordinaten

Eingabe ‘m ‘( . w ‘( . w ‘r . w ‘( . w ‘(Aus abe
G 00 g 55 g U g U g 3 -

Abbildung 62  Rendering Pipeline eines Raytracers [DMA]
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7.2 Optimierung der Szene

Rendering stellt den letzten Schritt in Richtung der angestrebten
fotorealistischen Aulenbereiche dar. Wer jedoch ,einfach drauf los
rendert* kann bdse Uberraschungen erleben. Nicht mehr benétigte
Konstruktionsprotokolle (history), uberflissige Knoten oder unnutze
Geometrie kdnnen den Renderer in seiner Geschwindigkeit bremsen oder
sogar dazu fuhren, dass er mitten in der Berechnung absturzt. Eine
einfache Art die angesprochenen Probleme zu I6sen, bietet Maya uber
.File > Optimize > Scene Size“ [ATL06]. In den Standardeinstellungen
werden hierdurch ungebrauchte Kurven, Materialien, Gruppen oder Lagen
entfernt. Braucht eine Szene ungewohnlich lange zum Rendern, kann
Uber ,Render > Render Diagnostics* der Script Editor gedtffnet werden,

welcher Vorschlage zur Optimierung bietet (Abbildung 63).

Abbildung 63  Optimierungsoptionen im Uberblick

Um Arbeitsspeicher (Maya2008 verbraucht ca. 300Mb) und damit
Rendering-Zeit zu sparen, bietet es sich an, den Renderingprozess nicht
direkt in Maya, sondern Uber die Kommandozeile des Betriebssystems

auszufuhren. Dazu startet man die Eingabeaufforderung und wechselt in
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das Verzeichnis, in dem die Projekt-Dateien im .mb oder .ma vorliegen.

Der Renderer wird jetzt GUber folgenden Befehl gestartet:
render -n 0 -s 1 -im est -cam camerat -rd c:\mayal\test test. mb -r mr

Dieses Kommando besagt, dass Maya alle verfugbaren Prozessoren
benutzen soll (-n 0), bei Frame1 anfangt (-s 1), Kamera ,camera1“ benutzt
(-cam camera1l), die Bilddateien im Verzeichnis c:\\maya\test\ speichert
(-rd c:\maya\test test.mb) und als Renderer ,Mental Ray“ benutzt wird

(-r mr).

7.3 Anforderungen an den Renderer

Die Wahl des Renderers spielt eine entscheidende Rolle. Nicht jeder
Renderer implementiert Berechnungen der globalen Beleuchtung wie die
bereits angesprochenen Verfahren des Final Gatherings oder des Photon
Mappings. Es gilt also vorher abzuklaren, wie die globale Beleuchtung am
besten realisiert werden kann und ob Effekte wie Kaustiken (,caustics®)
oder Bewegungsunscharfe (,motion blur®) in die Bildsysnthese einflieen
konnten. Neben der Implementation von Verfahren zur
Beleuchtungsberechnung oder Darstellung von Effekten, spielt die Zeit,
die ein Renderer zur Berechnung eines Bildes bendtigt eine weitere

wichtige Rolle.

Fir das Rendering des AulRenbereichs werden nun anhand der
Ergebnisse der vorangegangenen Kapitel verschiedene Anforderungen
festgehalten: Der Renderer muss Objekte vom Typ Fur, PaintEffects und
Fluids darstellen kdnnen. Es muss sich um einen Renderer handeln, der
Raytracing berechnen kann. Aullerdem muss er in der Lage sein,
erweiterte Methoden des Raytracings wie Final Gathering und Photon
Mapping anzuwenden. Maya bietet standardmaRig Maya Software, Maya

Hardware, Maya Vector und Mental Ray als Renderer an.
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7.3.1 Gegeniuberstellung von Mental Ray und Maya Software

An dieser Stelle sollen noch einmal kurz die wichtigsten Eigenschaften

von Mental Ray und Maya Software zusammengefasst werden.

Methode / Effekt Mental Ray Maya Software
Unterstiizung Unterstiitzung
Fur / Hair ja ja
Paint Effects nein ja
Fluid Effects ja ja
Displacements ja ja
Raytracing ja ja
Image Based Lighting ja nein
Final Gathering ja nein
Global Illumination ja nein
Photon Mapping ja nein
Kaustiken ja nein
Tabelle 1 Gegenlberstellung des Mental Ray- und Maya Software Renderers

Mental Ray unterstutzt bis auf Paint Effects alle wichtigen Methoden und
Effekte fur das Rendern der Szene. Paint Effects kdnnen jedoch in
Polygone konvertiert werden, so dass auch sie von Mental Ray dargestellt
werden konnen. Maya Software Renderer verfugt auller reinem
Raytracing uber keinerlei Verfahren, komplizierte Beleuchtungssituation
darzustellen. Flr das abschlieliende Rendering wird somit Mental Ray

verwendet.

7.4 Rendering Einstellungen

Nachdem sich fur Mental Ray als Renderer entschieden wurde, beschreibt
dieses Kapitel, welche Einstellungen fur die globalen Rendereinstellungen

zu wahlen sind.

Die globalen Rendereinstellungen, welche Uber ,Window > Rendering
Editors > Render Settings® aufgerufen werden, ermdglichen viele

Einstellungen, um die Qualitdt des Bildes zu erhéhen. Nachdem Mental
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Ray Uber ,Render Using > Mental Ray“ ausgewahlt ist, muss eingangs
das Format des zu rendernden Bildes und dessen Auflésung eingestellt
werden. Aufgrund der verlustfreien Komprimierung und einer Farbtiefe von
bis zu 32bit, bietet sich ,Targa“ (,Truevision Advanced Raster Graphics
Array [TGA]) als Bildformat an. Die Bilder sollen in einer Auflésung von
1024*768 Pixeln gerendert werden. Aufgrund der veranderten Auflésung
und der damit verbunden Anderungen des Seitenverhéaltnisses zu 4:3
(1.33), muss dies auch in den Kameraeinstellungen uber ,Film Back >

Film Gate > 36mm TV Projection” berlcksichtigt werden.

Nachdem Format und Auflésung gewahlt sind, geht es nun darum, die
Einstellungen von Mental Ray zu bearbeiten um eine gute Qualitat zu
erreichen. Um unerfahrenen Nutzern das Leben zu erleichtern, gibt Mental
Ray eine Reihe von Voreinstellungen vor. Je nach Anforderung kdnnen
hier bequem fertige Einstellungen flr Voransichten oder Produktions-

Qualitat ubernommen werden (Abbildung 64).

Abbildung 64  Mental Ray Voreinstellungen
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Mit der Voreinstellung ,Production sind bereits die wichtigsten
Einstellungen fur bestmdgliche Qualitat eingestellt. An einigen Punkten

muss jedoch nachgebessert werden:

Anti  Aliasing Quality: Antialiasing bezeichnet Techniken, die zur
Verminderung von unerwilnschten Alias-Effekten oder Treppeneffekten
fuhren [ECG96, S. 37]. Diese Einstellung dient der Kantenglattung
(Abbildung 65). Um eine moglichst genaue Darstellung der vielen, dinnen
Grashalme in der Szene zu erreichen, werden die Sampling Werte erhoht.
Neben den erhohten Sampling Werten wird die Filter Methode auf
,Mitchell“ geandert.

Raytracing: Uber die Einstellungen vom Raytracing lassen sich die Anzahl
der Reflexionen und Lichtbrechungen eines ausgesandten Strahls
anpassen. Die Standardeinstellungen sind fur Szenen mit vielen Objekten
ausgelegt und daher zu hoch. Die Einstellungen werden verringert, was

sich positiv auf die Renderzeit auswirkt.

Final Gathering: Bei den Einstellungen des Final Gatherings sollte in zwei
Schritten vorgegangen werden. Beim ersten Rendern sollte der Wert der
erzeugten Sekundarstrahlen sehr gering gewahlt werden. Wenn man mit
dem Ergebnis zufrieden ist, kann der Maximalwert von 1024 gewahlt

werden.

Abbildung 65  Antialiasing am Beispiel einer Teekanne
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8 Finale Renderings

Unter Berlcksichtigung der vorgestellten Anforderungen und Ergebnisse
wurde eine Szene erstellt, die einen Aulienbereich zeigt. Die gezeigte
Grasflache besteht im vorderen Teil des Bildes aus ,Paint Effects® Gras.
Im hinteren Teil wurde das Gras uUber ,Maya Fur® erstellt. Das Gelande
wurde Uber das ,Sculpt Surface Tool* erstellt. Das Gebirge im Hintergrund
wurde Uber die beschriebene Technik in Kapitel 4.2 erstellt. Die Wolken
sind ,echte“ 3D Wolken, welche Uber Fluids erzeugt wurden. Der Baum

wurde ebenfalls Uber ,Paint Effects” erstellt.

Die finalen Renderings (Abbildungen 66-68) zeigen die Szene zu

unterschiedlichen Lichtsituationen.

Abbildung 66  Finales Rendering - Mittags



Bachelorarbeit Florian Gebauer

87

Abbildung 67  Finales Rendering - Nachmittags

Abbildung 68  Finales Rendering - Sonnenuntergang



Bachelorarbeit Florian Gebauer

88

9 Schlussfolgerung

Im letzten Kapitel werden die erreichten Ziele beschrieben und mit der
ursprunglichen Themenstellung verglichen. Die Ergebnisse werden

kritisch betrachtet und aufgezeigt, wo Probleme entstanden.

9.1 Fazit

Um diese Arbeit abzuschliel3en, werden die erledigten Aufgaben, die in
der Themenstellung festgelegt wurden, beschrieben und die Ergebnisse

und Probleme bei der Erflllung der Aufgaben erklart.

Die erste Aufgabe bestand darin, ein ,nacktes” Gelande zu modellieren.
Zur Gestaltung im dreidimensionalen Raum ist zu sagen, dass es sich um
einen komplizierten und aufwandigen Prozess handelt, der stark von der
Erfahrung abhangig ist. So mussen bestimmte Ablaufe perfektioniert und
immer neue Moglichkeiten gesucht werden, das gewiunschte Ziel zu
erreichen. Nur so ist man in der Lage, seine Vorstellungen auch

umzusetzen.

Nachdem das Gelande modelliert wurde, bestand die zweite Aufgabe in
der Reproduktion der Vegetation an den Beispielen von Gras und
Baumen. An dieser Stelle stof3t man als ,reiner Modellierer® schnell an
seine Grenzen. Fur die fotorealistische Reproduktion von vegetativen
Objekten ist eine ausfuhrliche Studie der zu modellierenden Objekte in der
Natur unabdingbar. Ohne das genaue Wissen, wie diese Objekte in der
Natur mit zum Beispiel der Sonne interagieren, ist eine fotorealistische
Nachbildung nicht mdglich. Anhand von Beispielszenen wurde gezeigt,
dass es mit diesen Vorkenntnissen auf unterschiedliche Art und Weise

madglich ist, Baume und Gras fotorealistisch nachzubilden.

Nachdem alle Objekte der Szene modelliert waren, bestand die nachste

Aufgabe darin, die Szene realistisch auszuleuchten. Es bestand die
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Notwendigkeit die wichtigsten Begriffe zu diesem Thema erst theoretisch
zu bearbeiten. Anhand der daraus gewonnenen Erkenntnisse wurden
dann die verschiedenen Verfahren zur globalen Beleuchtung in Maya
angewandt. Durch Beispielszenen wurde eindrucksvoll gezeigt, dass mit
Hilfe von Techniken wie Image Based Lighting oder Physical Sun and Sky
fotorealistische Bilder von unterschiedlichen Szenarien oder Tageszeiten
moglich sind. Die Aufgabe realistische Lichtverhaltnisse in einer Szene zu
erzeugen, hat sich im Nachhinein als die schwierigste herausgestellt. Im
Gegensatz zur Modellierung von Objekten, wo Veranderungen direkt auf
der Maya-Buhne sichtbar sind, mussen bei der Einstellung der globalen
und lokalen Beleuchtung viele Testrenderings durchgefuhrt werden. Bis zu

einem zufriedenstellenden Ergebnis erfolgten viele kleine Annaherungen.

Die letzte Aufgabe im gestalterischen Bereich umfasste die Reproduktion
von komplexen Materialien wie Wolken und Wasser, sowie dem ,Anstrich®
des Gelandes. Die Texturierung des Geldndes brachte im finalen
Rendering einige Probleme mit sich. Der in Kapitel 5.3 erstellte Shader fur
das Gelande wurde Uber eine Layered Texture erzeugt. Es stellte sich im
Nachhinein heraus, dass Mental Ray diese Art von Shader nicht wie
gewunscht rendern kann: das Gelande wurde viel zu hell dargestellt. Auch
eine nachtragliche Anderung des ,Gelande-Shaders“ brachte keine
Besserung. Das Gelande wurde daraufhin mit einem einheitlichen ,Gras-

Shader” versehen.

Die Erstellung von Wasser und Wolken war dank der in Maya
implementierten Methoden relativ leicht. Zwar stand auch hier zu Anfang
die Beobachtung der Natur im Vordergrund, jedoch machten die von Maya
angebotenen Werkzeuge es einfach, recht schnell gute Ergebnisse zu
erzielen. Die Schwierigkeiten treten in diesem Prozessschritt erst bei der
Abstimmung dieser Materialien auf die Szene ein. Vor allem beim Wasser

fallt es deutlich auf, wenn selbst kleinste Details wie Farbe oder
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Wellengang nicht realistisch sind. Die finalen Renderings zeigen aber,
dass sich zum Beispiel die nachgebildeten Wolken nicht leicht von einem

echten Foto unterscheiden lassen.

Beim abschlieRenden Kapitel Rendering bestand die Aufgabe darin, die
fertige Szene in mdglichst guter Qualitat und mit so geringen Renderzeiten
wie moglich zu erzeugen. Aufgrund von vielen kleinen Versuchsreihen und

bereits gesammelter Erfahrung, wurden die endgultigen Bilder gerendert.

Zusammengefasst kann man sagen, dass die Erstellung von
fotorealistischen Aulienbereichen von drei Hauptfaktoren abhangt. Der
erste Faktor ist die umfassende Kenntnis Uber die verwendete 3D
Animationssoftware mit all ihren Moglichkeiten und Funktionen. Der zweite
Faktor besteht aus den theoretischen Kenntnissen Uber die verwendeten
Methoden. Der dritte und letzte Faktor beinhaltet ein ausfuhrliches Wissen

Uber die physikalischen Ablaufe in der Natur.

Ich hoffe, dass diese Arbeit vielen Studenten und anderen Interessierten
einen Einblick in den Produktionsprozess der Erstellung einer
fotorealistischen, virtuellen Welt gegeben hat. Diese Arbeit soll Anreize
geben, die vorgestellten Methoden auszuprobieren oder aufgrund der

gewonnenen Erkenntnisse neue Methoden zu entwickeln.



Bachelorarbeit Florian Gebauer

Literaturverzeichnis

Biicher
[BHAO2] Der Brockhaus (2002): Neunte Auflage

[MAYO07] Keywan Mahintorabi (2007): Maya 8 / 8.5 3D Grafik und 3D
Animation

[ECG96] Hans Joachim Bungartz, Michael Griebel, Chistoph Zenger
(1996): Einfithrung in die Computergraphik

[ATLO6] Lee Lanier (2006): Advanced Texturing and Lighting

[HDROS] Christian Bloch (2008): Das HDRI-Handbuch — High Dynamic
Range Imaging fiir Fotografen und Computergrafiker

Artikel

[PRP] Florian Gebauer (2008) Praxisprojekt: Erstellung eines realistischen
3D Modells der Fachhochschule unter Verwendung von Autodesk Maya

[SIG04] SIGGRAPH 04 (2004): The Elements of Nature: Realistic and
Interactive Techniques

[ITMO07] Ping Tan, Gang Zeng, Jingdong Wang, Sing Bing Kang, Long
Quan (2007) Image Based Tree Modelling

[APP68] A. Appel (1968): Some Techniques for Shading Machine
Renderings of Solids

[WHI80] T. Whitted (1980): An Improved Illumination Model for Shaded
Display

[RNLI98] Paul Devebec (1998): Rendering with natural lights

[JBL78] James F. Blinn (1978): Simulation of Wrinkled Surfaces



Bachelorarbeit Florian Gebauer

92

[MAD] Maya Help

[MIA] (2006):Mental Ray — Architectural Library

Internetseiten

[VXS] http://de.wikipedia.org/wiki/Vertex Shader
(28.12.2008)

[PXS] http://de.wikipedia.org/wiki/Pixel Shader
(28.12.2008)

[FOT] http://de.wikipedia.org/wiki/Fotorealismus
(29.12.2008)

[WIT] http://www.samui3d.com/3D/index.html
(03.01.2009)

[WAB] http://www.warnerbros.com/
(03.01.2009)

[AUT] http://usa.autodesk.com/adsk/servlet/index?
siteID=123112&1d=7635018
(18.01.2009)

[IMM] http://de.wikipedia.org/wiki/Immersion_(virtuelle Realit
%C3%A4t)
(14.01.2009)

[DMA] http://www.dma.ufg.ac.at/app/link/Grundlagen:3D-Grafik
(04.01.2009)

[MES] http://de.wikipedia.org/wiki/Meshing
(23.12.2008)



Bachelorarbeit Florian Gebauer

93

[LEF] http://www.lens-flare.de/?action=home&page=2 &keyword=&cat-
egory=plants
(01.02.2009)

[CGT] http://www.cgtextures.com/
(01.02.2009)

[PHH] http://www.photohomepage.de/galerien_reisefotografie allgaeu
(02.02.2009)

[TRG] http://www.treegenerator.com/
(13.01.2009)

[TRF] http://www.tree-factory.de/
(13.01.2009)

[UNR] http://www.unrealtechnology.com/
(13.01.2009)

[TES] http://de.wikipedia.org/wiki/Textursynthese
(14.01.2009)

[LAM] http://de.wikipedia.org/wiki/Lambertsches Gesetz
(08.01.2009)

[PBM] http://de.wikipedia.org/wiki/Phong-Beleuchtungsmodell
(08.01.2009)

[HDS] http://www.hdrshop.com/
(12.01.2009)

[JFB] http://research.microsoft.com/en-us/people/blinn/
(23.12.2008)

[TEX] http://de.wikipedia.org/wiki/Textur (Computergrafik)
(18.01.2009)



Bachelorarbeit Florian Gebauer

94

[DPM] http://de.wikipedia.org/wiki/Displacement Mapping
(18.01.2009)

[NVA] http://www.nvidia.com/object/bio_kirk.html
(17.01.2009)

[MBE] http://de.wikipedia.org/wiki/Machsche Streifen
(21.01.2009)

[ATS] http://neu.aggertalsperre.com/index.php?
option=com_rsgallery2 &Itemid=49
(20.01.2009)

[WFO] http://www.wetter-foto.de/images/011331.jpg
(27.01.2009)

[BMUT] http://www.bmu.de/luftreinhaltung/aktuell/1704.php
(27.01.2009)

[TGA] http://de.wikipedia.org/wiki/Targa Image File
(14.01.2009)



Bachelorarbeit Florian Gebauer

95

Erklarung

Ich versichere, die von mir vorgelegte Arbeit selbstandig verfasst zu
haben. Alle Stellen, die wortlich oder sinngemal aus veroffentlichten oder
nicht veroffentlichten Arbeiten anderer entnommen sind, habe ich als
entnommen kenntlich gemacht. Samtliche Quellen und Hilfsmittel, die ich
fur die Arbeit benutzt habe, sind angegeben. Die Arbeit hat mit gleichem
Inhalt bzw. in wesentlichen Teilen noch keiner anderen Prifungsbehorde

vorgelegen.

Gummersbach,den .................. Unterschrift:.....................


http://www.3dxo.com/list/749/4.htm

